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INTRODUCTION

It is important you read this manual (USER’S GUIDE) before using your device (7ﬁ€m Pocket PC)

to ensure its proper operation.

It is recommended that important data stored in your device should be saved to a memory card

(sold separately) or your personal computer (data transfer with ActiveSync®) on a regular basis.

Before returning your unit for service, be sure to back up your data and remove any confidential,

proprietary or personal information. Audiovox Communications Corp. is not responsible for

damage to or loss of any programs, data or removable storage media.

The purpose of the Safety Instructions in this manual is to provide you with warnings and safety

instructions that will assist in preventing the misuse of your device.

* All of the Safety Instructions that are contained in this manual must be read carefully and must
be fully understood before you attempt to use your device in order to avoid potential hazards that
could cause bodily injury or property damage, or could result in damage to your device or loss of
data.

* Always keep this manual in a convenient place for future reference.

Trademark Information

» Microsoft, ActiveSync, Outlook, Pocket Outlook, Windows, Windows NT, and the Windows logo
are either registered trademarks or trademarks of Microsoft Corporation in the United States
and/or other countries. Microsoft products are licensed to OEMs by Microsoft Licensing, Inc., a
wholly owned subsidiary of Microsoft Corporation.

» Sierra Wireless, the Sierra Wireless logo, red wave design and, Watcher are trademarks of
Sierra Wireless, Inc. Heart of the Wireless Machine is a registered trademark of Sierra Wireless,
Inc. © 2001 Sierra Wireless, inc.

» Other product names mentioned in this manual are trademarks or registered trademarks of the
respective companies.
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Product Name: Jhera
Model Number(s): CET0200A (PDA2032)

FCC Notice “Declaration of Conformity Information”

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

» Consult the dealer or an experienced radio/TV technician for help.

Warning: Only peripherals complying with the FCC class B limits may be attached to this
equipment.
Operation with non-compliant peripherals or peripherals not recommended by us is
likely to result in interference to radio and TV reception. Shielded cables must be used
between the external devices and the cradle connecting port.

Changes or modifications made to this equipment, not expressly approved by us or
parties authorized by us could void the user’s authority to operate the equipment.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two
conditions:

(1) This device may not cause harmful interference, and

(2) this device must accept any interference received, including interference that may cause
undesired operation.

Modifications or changes to this equipment not expressly approved by Audiovox may void the
user’s authority to operate the equipment.
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Product Name: USB Cradle
Model Number(s): CEX0208B (CRU2032B)

FCC Notice “Declaration of Conformity Information”

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

» Consult the dealer or an experienced radio/TV technician for help.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two
conditions:

(1) This device may not cause harmful interference, and

(2) this device must accept any interference received, including interference that may cause
undesired operation.
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SAFETY INSTRUCTIONS

» There are two categories of Safety Instructions included in this manual:
O Product Warnings, (i.e., what must never be done to assure avoiding those hazards that could
cause bodily injury or property damage); and
O User Directions (i.e., what must always be done to assure the safe use of your device).

* The Safety Instructions contained in this manual have been categorized in accordance
with the seriousness of the potential hazards through the use of Signal Words.

Those Signal Words, and their intended meanings, are as follows:

DANGER: Indicates that a failure to observe the Safety Instructions could result in death or
catastrophic bodily injury.

WARNING: Indicates that a failure to observe the Safety Instructions could result in serious
bodily injury.

CAUTION: Indicates that a failure to observe the Safety Instructions could result in minor
bodily injury or property damage.

NOTE: Designates important information that relates to activities and/or conditions that
might result in loss of data and/or damage to your device.

Safe Use And Operation of Your Device

All portable computers produce low levels of RF energy due to the generation of digital timing
pulses by its clock oscillator circuits. Your device has been equipped with internal shielding to
minimize stray emissions of RF energy. Airlines may nevertheless prohibit the on-board use of
portable PCs (and all other portable electronic devices that could potentially emit stray RF energy),
particularly during take-offs and landings, to prevent any possible interference with the reception of
signals by airborne electronic navigational devices. Other locations, such as hospitals, may also
restrict the use of Pocket PC’s and other devices that emit low-level RF energy.

WARNING

m Always request and obtain prior consent and approval of an authorized airline representative
before using your device aboard an aircraft.

m Always follow the instructions of the airline representative whenever using your device aboard
an aircraft, to prevent any possible interference with airborne electronic equipment.

WARNING

m Always comply with posted prohibitions of the use of RF-emitting devices, such as in hospitals.
Failure to follow such directives could result in the interference with medical equipment and/or
devices.

m Never come closer than 6 inches to a person with a heart pacemaker implant when using this
device. Failure to do so could result in interference with the function of the pacemaker.
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WARNING

m Never use your device while driving an automobile or any other moving vehicle. Always pull out
of traffic and come to a stop in a legally permissible and safe location before using your device.
Failure to do so could result in serious bodily injury in a traffic accident.

m Never use your device while walking. Usage while walking could result in bodily injury caused by
inattention to automobile traffic or other pedestrian hazards.

WARNING

m Never allow metallic objects, such as staples and paper clips, to enter inside your device.
Metallic objects, such as staples and paper clips, if allowed to enter your device, could cause the
generation of excess heat or fire.

m Never connect terminals (metal parts) to metallic objects (such as wires). Connecting terminals
to metal objects could cause excessive heat or fire.

m Always immediately disconnect the AC Adapter from the power outlet and turn the battery switch
to the “Stop” position in the event the device emits an unusual odor or sound or generates
smoke.

WARNING

m Never use or store your device in the following locations:

* Anywhere it may be exposed to water, such as a bathroom or sauna;
* In conditions of high humidity, such as in the rain or fog;

» Where your device will be exposed to high temperatures, such as near a fire or equipment
that emits high temperatures;

* In direct sunlight; or

* In a sealed automobile left in the sun and subject to high temperatures.

» Never store or transport flammable liquids, gases or explosive materials in the same
compartment of your automobile as the device or any of its accessories, as possible sparking
in the PC could cause ignition or explosion.

» When driving, always secure your device in its softcase, when it is not in use. Never place
your device on the passenger seat or any place else in the car where it can become a
projectile during a collision or stop.

m Never drop your device or subject it to severe shock. Dropping your device or subjecting it to
severe shock could cause the built-in battery to leak, ignite and/or rupture.

m Always immediately remove your device and its battery from the vicinity of any source of heat,
such as an open flame, in the event the built-in battery leaks liquid or emits an unusual odor.
Continued use of your device under either of these conditions could cause ignition (i.e., fire) of
the leaked battery liquid, or rupture.

m Never touch any fluid that might leak from the built-in battery. Such liquid when in contact with
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the eyes or skin, could cause injury to the skin or eyes. Should the liquid come into contact
with the eyes, irrigate the eyes thoroughly with clean water and immediately seek medical
attention. In the event the liquid comes into contact with the skin or clothing, wash it away
immediately with clean water.

Failure to follow the above directions concerning use and storage could result in bodily injury and/
or property damage due to battery liquid leakage, fire or rupture. Failure to follow the above
directions concerning use and storage could also result in damage to your device.

WARNING

m Always use authorized Audiovox accessories and optional devices when operating this device,
as the use of incompatible auxiliary equipment could result in fire, electric shock or other bodily
injury. The use of unauthorized accessories will also void your Warranty.

WARNING

m Never attempt to disassemble, repair or make any modification to your device. Disassembly,
modification or any attempt at repair could cause bodily injury or property damage, as well as
damage to the device itself.

WARNING

m Your device is not a toy. Never allow children to play with your device. Misuse, rough or improper
handling of your device by children could result in serious bodily injury for any of the enumerated
safety warnings in this manual. In addition, always keep all accessories and components out of
the reach of small children as small parts might present a choking hazard.

CAUTION

m Never raise the sound volume level too high when using your device with earphones. An
excessive sound volume level could cause damage to your hearing.

m Never touch the liquid that might leak from a broken liquid crystal display. Contact with this liquid
could cause a skin rash. If the crystal display liquid should come into contact with the skin or
clothing, wash it immediately with clean water.

NOTE

m Under certain conditions, data may be lost, including:
O Failure to follow all instructions for use and warnings in this manual.
O Misuse of your device;
O Subjecting the main unit of your device to static electricity and/or noise;
O Total loss of electric charge in the built-in battery; and
O Servicing of your device.
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m Use of your device in locations where the following ambient environmental conditions are
exceeded:

O Under normal operational use ambient temperatures not less than 32°F and not in excess of
104°F (0°C and 40°C);

O With humidity of not less than 30% or in excess of 80%; and

[0 When charging the battery ambient temperatures not less than 41°F and not to exceed 95°F
(5°C and 35°C).

m Do not store or use your device in the following locations:

O Those subject to extremely high or low temperatures;

O Dusty locations; and

[0 Locations or sites subject to strong vibration.

Use or storage in these location, sites or areas can result in product failure, malfunction or loss
of data.

m Avoid connecting your device to an external device such as a computer in an environment likely
to be affected by static electricity. For example, during low-humidity weather, shuffling your
shoes upon a rug can produce static electricity. Before you handle your computer, you should
touch a grounded object to discharge any static electricity from your body.

m Do not subject your device to sudden and severe temperature changes. This could result in
moisture condensation in the device that could cause damage to your device, computer function
loss, and/or the loss of data. In the event of moisture condensation, allow your device to dry out
completely.

m It is normal for the AC Adapter to become warm when charging.

m Disconnect the power plug from the outlet when not in use.

m Take care not to sit on device when it is located in the back pocket of trousers, etc. This could
cause damage to your device or malfunction of the device functions.

m Do not place objects on top of your device or drop them on top of your device. This could cause
damage to your device and/or malfunction.

m Never paint or apply any foreign substance to this device as this can clog and damage moving
parts.

m Clean terminals (metallic parts) on a regular basis with a dry cotton swab. Dirty terminals could
affect battery charging.

m Never use organic solvents such as benzene or paint thinner to clean your device. Use of these
solvents can cause deformation or discoloration. Wipe dirty parts with a soft dry cloth.

m Do not wipe the display with a damp or wet cloth or touch the display with damp or wet hands.
Wiping or touching the display under this condition can cause product failure or malfunction.
Always use a soft dry cloth to wipe the display.

m When using the optional “SD memory card”, be sure to read the relevant instruction manual and
ensure that you know the proper procedures for their use and compatibility with your device.
O Never subject the card to any severe shock while connected to your device. Such a shock can
cause damage to the card and a malfunction.

[0 Do not carry your device with the card connected to it. This can result in the damage or loss of
the card.
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m Never connect cradle terminals with metallic objects, such as wires. Connecting these terminals
with metallic objects may cause the production of excess heat, burns and damage to the charger
and/or your device.

CAUTION

m A lithium ion battery is used in this device. When a replacement is needed, please request the
dealer from whom your device was purchased to assist you.

m Lithium ion batteries are recyclable. When you replace your built-in battery, please request the
repair center to recycle the battery in accordance with RBRC standards. When disposing of the
battery by yourself, please call RBRC at (800) 822-2237 for tips on the proper disposal of the
lithium ion battery. Never dispose of the battery with ordinary waste.

Safe Use of AC Adapter

DANGER

m Never attempt to disassemble or repair an AC Adapter, and never alter the power cords or plugs
as exposure to electric shock hazards may result.

Always contact an authorized Audiovox service center, if repair or replacement is required.

m If the plug will not fit into the available outlet, have a proper outlet installed by a qualified
electrician. Improper connection can result in the risk of electric shock. Never attempt to modify
or alter the AC cord or plug of the AC Adapter.

WARNING

m Never allow the AC Adapter to come into contact with water or any other liquid. Water or any
other liquid in contact with the AC Adapter can create a risk of fire or electric shock.

m Always use the authorized Audiovox AC Adapter to avoid any risk of fire or damage to your
device or battery. Bodily injury or property damage may occur as a result of the use of an
unauthorized and incompatible AC Adapter.

m Never use an AC Adapter if it has a damaged or worn power cord or plug. The use of damaged
or worn power cords or plugs could result in electric shock, burns or fire. Contact an authorized
Audiovox service center immediately to obtain a suitable replacement.
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m Never connect or disconnect the AC Adapter with wet hands. Connecting or disconnecting the
AC Adapter to a power source with wet hands could cause electric shock.

m Never attempt to connect or disconnect the power plug with damp or wet hands. Connecting or
disconnecting the power plug with damp or wet hands could result in an electric shock.

m Always unplug the AC Adapter from the power source before attempting any cleaning in order to
avoid the risk of electric shock. Always use a soft dry cloth to clean the equipment, after it has
been unplugged.

m Never attempt to use an unauthorized AC Adapter with your device in order to avoid any risk of

bodily injury or property damage. Since unauthorized accessories have different specifications,
they may be incompatible with your device.

CAUTION

m Never place an AC Adapter on a wooden surface (or any other surface that could be marred by
exposure to heat) while it is in use. Since its surface temperature of the AC adapter increases
during normal use, always rest it on a suitable heat-insulating material.

m Never cover the AC Adapter with any object while it is in use, and never place it adjacent to a
heat source. An excessive temperature increase could detrimentally affect its performance.

m Never place a Power Supply Cable near a heat source, as damage to the cord or to its insulation
could result.

m Always use a surge protector when utilizing the AC Adapter during an electrical storm.
Otherwise, a power surge could result in the loss of stored data.

m Always insert the power plug to a household electric outlet supplying 110V AC.

m When traveling abroad, never plug the AC Adapter into a power source that does not correspond
to both the voltage and the frequency specified on the rating plate of the AC Adapter, as
equipment damage will result. When you connect to a power supply of more than 125V AC,
change the Power Supply Cable with one that corresponds to the power supply specification.

CAUTION

m Always locate an accessory Power Supply Cable so that it will not be stepped on, tripped over,
or otherwise subjected to damage or stress.

m Never place heavy objects on a Power Supply Cable, as this could result in damage to the cord.

m Never bend or twist a Power Supply Cable, and never pull on a Power Supply Cable in an
attempt to remove an AC Adapter or accessory plug from a socket. Always grasp the AC Adapter
or the accessory plug directly when unplugging the Power Supply Cable in order to avoid
damaging the cable.

m Always ensure the power plug pins are clean and free of dust or other foreign material by wiping
the pins with a clean dry cloth. Dust or other foreign material accumulation on the power plug
pins could cause fire.

m Always disconnect the AC Adapter from the power source when it is not in use.

10
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SAFE USE AND OPERATION OF DEVICE (WIRELESS HANDHELD
PHONE)

Read this information before using your device.

Your device is a low power radio transmitter and receiver. When it is ON, it receives and also
sends out radiofrequency (RF) signals.

FCC RF EXPOSURE INFORMATION

In August 1996, the Federal Communications Commission (FCC) of the United States, with its
action in Report and Order FCC 96-326, adopted an updated safety standard for human exposure
to radiofrequency (RF) electromagnetic energy emitted by FCC regulated transmitters. Those
guidelines are consistent with the safety standard previously set by both U.S. and international
standards bodies. The design of this device complies with the FCC guidelines and these
international standards.

Use only the supplied or an approved antenna. Unauthorized antennas, damaged antennas,
madifications, or attachments could impair call quality, damage the phone, or result in violation of
FCC regulations. Please contact your local dealer for replacement antenna.

Body-worn Operation

This device was tested with the BC-2032 belt clip and LB-2032 softcase, offered by Audiovox, as
an accessory to this device and was found to comply with the FCC exposure requirements. Other
third-party belt clip and softcase or holsters have not been tested with this device and therefore
their compliance with the FCC RF exposure limits cannot be confirmed.

When operating this device, a minimum separation distance of 1.0 inch (2.5 cm) must be
maintained between the user’s body and the device, including its antenna, to comply with the FCC
exposure limits.

This particular device has not been designed for held-to-ear use and should never be used against
the ear. It is designed to be used in a belt clip with an earphone microphone or as a speakerphone.

For more information about RF exposure, please visit the FCC website at www.fcc.gov .

PHONE OPERATION
Normal position: In front of your face, hold the device keeping distance from your body. or, In
front of your face, hold the device wearing the earpiece keeping distance from your body.
Tips on Efficient Operation:
For your phone to operate most efficiently:

» Do not touch the antenna unnecessarily and keep the antenna from metal when the phone is in
use. Contact with the antenna affects call quality and may cause the phone to operate at a
higher power level than otherwise needed.

11
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WARNING

DRIVING

Never use a device and/or cell phone while driving an automobile or any other moving vehicle.
Always pull out of traffic and come to a stop in a legally permissible and safe location before using
your device. Failure to do so could result in serious bodily injury in a traffic accident.

WARNING

ELECTRONIC DEVICES

Most modern electronic equipment is shielded from RF signals. However, certain electronic
equipment may not be shielded against the RF signals from your device.

Pacemakers

The Health Industry Manufacturers Association recommends that a minimum separation of six (6")
inches must be maintained between your device and a pacemaker to avoid potential interference
with the pacemaker. These recommendations are consistent with the independent research and
recommendations of Wireless Technology Research.

Persons with pacemakers:

» Should ALWAYS keep the device more than six (6”) inches from their pacemaker when the
device is turned ON.

» Should not carry the device in a breast pocket.

 If you have any reason to suspect that interference is taking place, turn your device OFF
immediately.

WARNING

Vehicles

RF signals may affect improperly installed or inadequately shielded electronic systems in motor
vehicles. Check with the manufacturer or its representative regarding your vehicle. You should also
consult the manufacturer of any equipment that has been added to your vehicle.

Posted Facilities

Turn your device OFF in any facility where posted notices require so.

AIRCRAFT

FCC regulations prohibit using your device while in the air. Turn your device OFF before boarding
an aircratft.

12
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BLASTING AREAS

To avoid interfering with blasting operations, turn your device OFF when in a “Blasting area” or in
areas posted “Turn off two-way radio”. Obey all signs and instructions.

POTENTIALLY EXPLOSIVE ATMOSPHERES

Turn your device OFF when in any area with a potentially explosive atmosphere and obey all signs
and instructions. Sparks in such areas could cause an explosion or fire resulting in bodily injury or
even death. Areas with a potentially explosive atmosphere are often, but not always marked
clearly. Potential areas may include: fueling areas (such as gasoline stations); below deck on
boats; fuel or chemical transfer or storage facilities; vehicles using liquefied petroleum gas (such as
propane or butane); areas where the air contains chemicals or particles (such as grain, dust, or
metal powders); and any other area where you would normally be advised to turn off your vehicle
engine.

For Vehicles Equipped with an Air Bag

An air bag inflates with great force. DO NOT place objects, including either installed or portable
wireless equipment, in the area over the air bag or in the air bag deployment area. If in-vehicle
wireless equipment is improperly installed and the air bag inflates, serious injury could result.

CAUTION

Hearing Aids

Some digital wireless phones may interfere with some hearing aids. In the event of such
interference, you may want to consult your service provider [or call the customer service line to
discuss alternatives].

Other Medical Devices

If you use any other personal medical device, consult the manufacturer of your device to determine
if they are adequately shielded from external RF energy. Your physician may be able to assist you
in obtaining this information.

Turn your device OFF in health care facilities when any regulations posted in these areas instruct
you to do so. Hospitals or health care facilities may be using equipment that could be sensitive to
external RF energy.

“device OFF" means to turn the Radio Standby Switch “OFF”, then turn the power off using the
Power button.

13
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SAR Information

Specific Absorption Rate

THIS MODEL PHONE MEETS THE GOVERNMENT'S REQUIREMENTS FOR
EXPOSURE TO RADIO WAVES.

Your wireless phone is a radio transmitter and receiver. It is designed and manufactured not to
exceed the emission limits for exposure to radiofrequency (RF) energy set by the Federal
Communications Commission of the U.S. Government. These limits are part of comprehensive
guidelines and establish permitted levels of RF energy for the general population. The guidelines
are based on standards that were developed by independent scientific organizations through
periodic and thorough evaluation of scientific studies. The standards include a substantial safety
margin designed to assure the safety of all persons, regardless of age and health.

The exposure standard for wireless mobile phones employs a unit of measurement known as the
Specific Absorption Rate, or SAR. The SAR limit set by the FCC is 1.6 W/kg.* Tests for SAR are
conducted with the phone transmitting at its highest certified power level in all tested frequency
bands. Although the SAR is determined at the highest certified power level, the actual SAR level of
the phone while operating can be well below the maximum value. This is because the phone is
designed to operate at multiple power levels so as to use only the power required to reach the
network. In general, the closer you are to a wireless base station antenna, the lower the power
output.

Before a phone model is available for sale to the public, it must be tested and certified to the FCC
that it does not exceed the limit established by the government-adopted requirement for safe
exposure. The tests are performed in positions and locations (e.g., worn on the body) as required
by the FCC for each model. The highest SAR value for this model phone tested when being worn
on the body, as described in this user guide, is 0.56W/kg. (Body-worn measurements differ among
phone models, depending upon available accessories and FCC requirements). While there may be
differences between the SAR levels of various phones and at various positions, they all meet the
government requirement for safe exposure.

The FCC has granted an Equipment Authorization for this model phone with all reported SAR
levels evaluated as in compliance with the FCC RF exposure guidelines. SAR information on this
model phone is on file with the FCC and can be found under the Display Grant section of http://
www.fcc.gov/oet/fceid after searching on FCC ID CJ6CET0200MT.

Additional information on Specific Absorption Rates (SAR) can be found on the Cellular
Telecommunications & Internet Association (CTIA) web-site at http://www.phonefacts.net.

* In the United States and Canada, the SAR limit for mobile phones used by the public is 1.6
watts/kg (W/kg) averaged over one gram of tissue. The standard incorporates a substantial
margin of safety to give additional protection for the public and to account for any variations in
measurements.

14
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Chapter 1: Getting Started

Welcome

Congratulations on the purchase of your Thena Pocket PC. You can keep your most important

DRAFT

business and personal information up to date and close at hand. And with the power of Microsoft®

ActiveSync® you can synchronize and download information on your desktop or laptop computer

with your handheld device.
With your Thera Pocket PC you can:
» Make and receive phone calls.

Send and receive e-mails.

Download web pages.

Make handwritten notes

Instantly view the day’s appointments with the touch of a button.

Where to Find Information

18

This manual describes your device hardware, an overview of its programs and explains how to

connect to a computer, network, or the Internet. See the Quick Start Card for instructions on setting

up the unit and installing ActiveSync®.

For information on:
Programs on your device

See this source:

This manual and device Help. To view Help, tap P

Additional programs that can be
installed on the device

The Jhewa Companion CD.

Connecting to and synchronizing with a
computer

The Quick Start Card or ActiveSync® Help on your computer.
To view Help, click Help then Microsoft ActiveSync Help.

Last-minute updates and detailed
technical information

The Read Me files, located in the Microsoft ActiveSync folder
on the computer and on the 7ﬁ§/la Companion CD.

Up-to-date information on Pocket PC

http://www.microsoft.com/mobile/pocketpc

Product & technical support information
about 7hewa and other Audiovox
Pocket PC devices.

http://www.audiovox.com/pda
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Parts Names and Function

B Main Unit (front view)

Incoming Call / System Notification LED

Charging LED
Power Button / Front Light Button

Mlcrophone

——————Touch Screen
Speaker
@%

Program Button 1, 2, 3 & 4
(From the Left) \
SEND Button

O @ Cradle Connection Port
END Button \ \\ /\ o

Cursor Button / Navigation Button

Fixed Antenna

Record Button
(Program Button 5)

Radio Standby Switch —A

AC Adapter Jack

B The Cradle

\/\

USB Cradle

M Initial Setting of Program Buttons

Program button 1 ........ Calendar
Program button 2 ........ Tasks

Program button 3 ........ Home

Program button 4 ........ Contacts
Program button 5 ........ Voice Recorder

20
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B Main Unit (back view)

Stylus Holder Headphone Jack
SD Card Slot

&

—0/ Hand Strap Attachment

Stylus

Reset Switch

Infrared Port

Color Panel

21
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Power Button / Front Light Button

Press this to turn the device and the front light on/off.

Power button When the power is off When the power is on
Press it for some time. The power turns on. The front light alternately turns on/off.
Press it quickly. The power turns on. The power turns off.

Even if the power is turned off, pressing the program button turns the power on and the program
screen is displayed. (However, you can change the setting. See “Setting Power” in “Customizing
Your Device” later in this chapter.)

Battery Switch

The Battery Switch supplies/cuts the battery power to the device. When shipped the setting is
“Stop.” Before using your device for the first time:

1. Detach the Color Panel (see illustration) to expose the Battery Switch.

2. Confirm that the Radio Standby Switch is set to “OFF”, then slide the Battery Switch to “Supply”
(lower side).

Battery Switch Lock

22
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3. Reattach the Color Panel.

é} Note Returning the switch to the “Stop” (the upper side) resets the device back to its factory
settings - initial setup will need to be repeated. To move to the “Stop” side, slide the
switch while inserting the stylus into the Battery Switch Lock.

Charging LED

» Steady orange .............. Built-in battery charging

* Flashing yellow ............. Charging has stopped due to extreme temperatures. Charge at a
temperature of approximately 41°F - 95°F (5°C and 35°C).

» Steady green ............... Built-in battery fully charged.

» Steady yellow ............... Built-in battery charging but level is not strong enough to power.

Incoming Call / System Notification LED

« Fast flashing orange ..... Incoming call
(Approx. 2Hz)

* Slow flashing orange .... Indicates alarm as set through Calendar or Tasks.
(Approx. 1Hz)

Radio Standby Switch

Determines functionality of device. To turn ON, slide Radio Standby Switch to the upper side.
* ON....... Can be used as phone to make and receive calls
e OFF ..... Cannot function as a phone

Using the Stylus

Used only on touch-screen for menu selection or data input.
» Tap: Touch the screen once with the stylus to open items and select options.

» Drag: Hold the stylus on the screen and drag it across to select text and images. Drag in a list
to select multiple items.

» Tap and hold: Tap and hold the stylus on an item to see a list of actions available for that
item. On the pop-up menu that appears, tap the action you want to perform.

@ Note Only use the supplied stylus on the touch screen. If the stylus tip becomes damage
replace with a new one. Using a ballpoint pen or damaged stylus may damage the
screen.

23
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About Cursor Button

Navigate the cursor on screen by pressing the upper, lower, right or left part of the cursor button.
In the “New” menu press the center of the button to select the program you wish to launch.

@ Note The cursor movement depends on the screen. When the cursor is at the right or the left
side of the screen, it may not move.

Earphone Microphone

The supplied Earphone Microphone can be used to receive phone calls. When the Earphone
Microphone is inserted into the unit, the microphone and speaker on the main unit will become
inactive.

Also, this microphone can be used as a recorder.

Microphone

Clip
You can attach the
Earphone Microphone

This device’s phone component can be used with the Earphone Microphone or as a
speakerphone. Unlike conventional cell phones, it is not designed to be held against the head in
conversation. Such unauthorized use of the phone, without an Earphone Microphone or other than
as a speakerphone, is contrary to the design of this product and is not recommended. For
instructions on how to use the phone with Earphone Microphone or as a speakerphone, please
refer to page 61 of this manual.
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Audio Remote Controller with Microphone

The supplied Audio Remote Controller with Microphone can be used to listen to audio playback.

DRAFT

Combined with the headphone (sold separately), it can be used to receive phone calls. When the

Audio Remote plug is inserted into the device, the microphone and speaker on the main unit will

become inactive.
Also, this microphone can be used as a recorder.

Headphone
(sold separately)

SEND / END button

Play / Pause, FF,
REW Switch

Play a D

H &
revious song ——

Play / Pause
y Skip to the

next song

Hold Switch
All other remote
keys become inactive
when “HOLD” is set.

The SEND/END button is active.

Microphone Audio Remote Controller with Microphone

Volume button

+7 X
Adjust\\—'
Volume

to your pocket, etc., by using this clip.

Stop button I
Stereo headphone jack

During a call, it is not possible to adjust the volume with the Volume button.

Use g 3.5mm mini-plug type headphone to connect to the Audio Remote Controller with
Microphone.

Clip
/ You can attach the Audio Remote Controller with Microphone

This device’s phone component can be used with the Audio Remote Controller with Microphone or
as a speakerphone. Unlike conventional cell phones, it is not designed to be held against the head

in conversation. Such unauthorized use of the phone, without an Audio Remote Controller with
Microphone or other than as a speakerphone, is contrary to the design of this product and is not
recommended. For instructions on how to use the phone with Audio Remote Controller with

Microphone or as a speakerphone, please refer to page 61 of this manual.
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Battery Charging

When using the device for the first time, set the Battery Switch to the supply side (see page 22),
then fully charge the battery.

Charging the Battery

You can use two charging methods.
When you connect the AC Adapter to the device, turn the unit off.

» Connect the supplied AC Adapter to the cradle as shown in the figure below, and then insert
the device into the cradle.

é/? Note Charge the battery in an environment between 41°F - 95°F (5°C and 35°C). Temperatures
outside this range may pause the charging process. Refer to page 23 for additional
information on charging.
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Maximizing the Battery Operating Time
¢ Whenever possible, use the device with the AC Adapter — especially when it is connected to
your computer.

e Select the short powered-off time in the setting menu. This will shorten the time the unit will
remain on if not used. See “Customizing Your Device” later in this chapter for more information.

e Turn off the front light.

e Set the screen brightness to power savings mode (front light off) or shorten the front light
turn-off time. See “Customizing Your Device” later in this chapter for more information.

¢ For optimal performance use in an environment between 59°F - 77°F (15°C and 25°C).
Anything outside this temperature range may decrease the operating time.

Battery Life

The built-in battery has a limited life that will gradually decrease after repeated charging. Replace
the battery when you notice a dramatic decrease in battery performance.

Battery Charge Level and Stored Data Protection

If the battery charge level becomes extremely low or completely discharged, stored memory data
will be deleted. As soon as the low battery status icon or the alarm message appears, immediately
connect the AC Adapter to the device so it can charge.

» The battery gradually discharges even when not in use. If not used for a long time, it may
completely discharge.

* It is strongly recommended that you save the device’'s memory data to your computer or a
storage card. The manufacturer is not responsible for data changed or lost due to battery
discharge.

27
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Initial Setup

28

When using your device for the first time, completely charge the battery then follow the initial setup
procedures below:

1. Press the Power button and when the welcome screen appears, tap the screen with the stylus
to start the setup process.
2. When the align screen appears, follow the directions for adjusting the touch screen until the
stylus screen appears.
« If a finger or any other object touches the screen during a correction, it will be cancelled.
Repeat the correction procedure.

@ Note To display the align screen after the initial setup process, press the Record button while

pressing the center of the navigation button, or by tapping , Settings, System, and
then Screen.

3. Read and understand how to use the stylus then tap Next.

@ Note See “Using the Stylus” on page 23 for more information.

4. Read and understand pop-up menu operation, then tap Next.
* Read the on-screen explanation and then operate the screen.
Display the pop-up menus, and cut and paste the data according to the screen instructions.
* When you finished the paste operation, this stage is completed. Tap Next.
5. Follow the directions for setting the location, then tap Next.

6. When the complete screen appears, initial setup is finished. The Today screen will appear and
the device will be ready to use. See “Today Screen,” later in this chapter for more information.
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Setup Options
Method of Setting Card into SD Card Slot

To insert a card:

1. Turn off the power.

2. Insert the card with its contact surface (metal contact surface) facing backward into the
device.

To remove a card:

1. Make sure that no application is accessing the SD card.
2. Turn off the power.

3. Lightly press down on the card until a clicking sound is heard. The card will pop out slightly
from the slot.

4. Pull the card straight up to remove.
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How to Change the Color Panel

You can change the Color Panel (optional).

To remove the Color Panel, unlock in the direction of the arrow, as shown in the figure below, then
detach the Color Panel by pulling it upward.

To attach a new Color Panel, perform the procedure in reverse order.
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Connecting to a Computer

Before connecting your device to a computer, check the following.
» ActiveSync® is on your computer. (See Chapter 4 for more information)
e The device is turned off.
» The computer you’re connecting has an available USB port for the cradle.

To connect using the supplied USB cradle:
1. Connect the USB cradle to your computer as shown in the illustration below.

USB port

2. Insert the device into the USB cradle.

Make sure that the connector on the cradle is inserted into the port on the bottom of the device.
Data can not be transferred if the connection is not made.

When your device is properly inserted into the cradle, your device will turn on automatically and
ActiveSync® will automatically open on your computer.

@ Note Avoid using your device in environments that are likely to be affected by static electricity
or are prone to high electrical noise. If you connect your device to a computer via the
docking cradle for data transfer or data restoration purposes, Audiovox Communications
Corp. will not be responsible for any device or computer malfunction, problems with data
transfer or (strikethrough: restoration creation or data communication), or data
modification/loss that may occur in these environments.
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Today Screen

The first time you turn on your device each day, or after 4 hours of inactivity, the Today screen will
be displayed. It can be accessed by tapping @ and then Today.

Tap to switch
to a program.

Tap to change date and time.

Tap to open information setting.

— Your day at a glance.

Tap to create a new item. Tap to view connection status.
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Following are some of the status icons you may see.

‘ Status Icon Meaning
o Turns all sounds on and off and changes the volume level
Y Batteries charging
i Batteries are low
|:'_! Batteries are very low
(] Batteries are full
< Active connection
@ Synchronization is beginning or ending
"fm Synchronization in process
i Notification that a new program or system update is available
2 Instant message received

E-mail message received

@ Note If more notification icons need to be displayed than there is room for on the screen, the

() will display. Tap the icon to view all the notifications.

Watcher™ Status Icons

When Watcher™ is activated, the following icons may be displayed on the command bar of the

Today screen.

‘ Status Icon Meaning
“r Not connected to the network
o> Connected to the network
%] There is a missed call
= There is an unread SMS message
= There is a voice mail message
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Programs

Switch from one program to another by using the fwj menu. To access programs not listed on the

34

drop down menu, tap f&¥]

, Programs, then the desired program.

DRAFT

You can also switch to another program by pressing any of the five program buttons located on the

front and side of the device. The icons above the buttons identify the factory set programs (from
left to right) — Calendar, Tasks, Home and Contacts. The Record button on the side is for voice
recording. To reprogram these buttons to activate other programs, see page 47, “Adjusting

Settings.”

The following table is a partial list of programs on your device.

‘ Icon Program Description ‘
@ ActiveSync® Synchronize information between your device and your
computer.
Calendar Keep track of your appointments and create meeting requests.
Contacts Keep track of your friends and colleagues.
Inbox Send and receive e-mail messages.

files from the Internet.

Pocket Internet Explorer | Browse Web and WAP sites, and download new programs and

X =0 ®|P)0EE

Notes Create handwritten or typed notes, drawings, and recordings.
Tasks Keep track of your tasks.
Pocket Excel Create Excel spreadsheets or view and edit Excel

spreadsheets created on your computer.

ﬂ MSN® Messenger Send and receive instant messages with your MSN® Messenger
contacts.
Pocket Word Create new documents or view and edit Word documents

E

created on your computer.

Besides the program in the above table, Windows Media Player, Backup, Calculator, File Explorer,
Home, Infrared Receive, Microsoft Reader, Terminal Services, Watcher, Solitaire are pre- installed.
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Navigation Bar and Command Bar

The navigation bar, located at the top of the screen, displays the active program and time, and
allows you to switch programs and close screens.

The command bar at

menu names, buttons and the Input Panel button. Tap New to create a new item in the program.

l.%.i"|5l:art
Ak &

the bottom of the screen performs tasks in the open program, and includes

Tap to view notification messages.

Tap to change volume or mute the device.

£ 12:08 Tap to display the current date
RS and the next schedule.

—1— Tap to quickly select a program

% Today

@ ActiveSync
=] Calendar
['=| Contacts

@ Inbox

|,_| Notes
Tasks

ﬁ Internet Explorer

you have recently used.

—1—— Tap to select a program.

[/ Programs
g Settings

—1— Tap to see additional programs.
—1+—— Tap to customize the device.

- Find
e Help

| New button. | Input Panel button.
I 1
New Edit Tools =1 | B~
Menu Buttons.
names.

DRAFT
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Pop-up Menus

Pop-up menus provide quick access to select an action for an item, and vary with each program.
To access a pop-up menu, tap and hold the stylus on the item you want to perform the action on.
When the menu appears, lift the stylus and tap the desired action. Tap anywhere outside the menu
to close it.

All Tasks « Priority -

[ ]! Send status report
[] Buy birthday gift
[] call Maria

[] Proof new proposal

Create Copy the pop-up menu.

Delete Task Lift the stylus and tap
the action you want.

Beam Task...
Tap outside the menu
to close it without performing
an action.

New Tools E|*

Notifications

Your device can remind you when you have an appointment or task scheduled, or serve as an
alarm clock. Notification options include:

* A message box on the screen
¢ A sound (which you select)

» Aflashing light
To select reminder types and sounds, tap [»j and then Settings. In the Personal tab, tap Sounds

& Notifications. The selected options will apply for the entire device.
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Entering Information

Options for entering new information include:
 Using the input panel to enter typed text.
« Writing or drawing pictures directly on the screen.
« Recording a message by speaking into the microphone.
» Using Microsoft® ActiveSync® to synchronize or copy information from your computer to the
your device.

Entering Text Using the Input Panel

Use the input panel to enter information in any program by either typing using the soft keyboard, or
by writing using the Letter Recognizer, Block Recognizer or Transcriber. With either option the

characters will appear as typed text on the screen.
To view/hide the input panel, tap the Input Panel button, then tap the arrow next to it to see your

options.
Options...
Block Recognizer
* Keyboard _
i Select an input method.
Letter Recognizer
Transcriber
New Edit Yiew Tools T, |iﬂj Tap to see your choices.

Input Panel button.
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When you use the input panel, your device anticipates the word you are typing or writing and
displays it above the input panel. When you tap the displayed word, it is inserted into your text at
the insertion point. The more you use your device, the more words it learns to anticipate.

Monthly mee

Tap here if this

mee@ is the right word.

123}1[2[3]4]s|6|7[8][9]0]-[=]
Tablqwle[r|t[y[u|ifo[p[[]]
CaPla[s[d[f]a[h]j[k][I];

shift z[2 [c[v[b[n[m][.].[/]
culai] " [\ ] [4[t]e]>
New Edit Tools [= |E‘

@ Note To change word suggestion options, such as the number of words suggested at one time,

il Settings, Personal tab, Input, and then the Word Completion tab.

To type with the soft keyboard:

1. Tap the arrow next to the Input Panel button and then Keyboard.
2. Use the stylus to tap the keys on the soft keyboard.

To use Letter Recognizer:

With Letter Recognizer you can write letters using the stylus just as you would on paper.
1. Tap the arrow next to the Input Panel button and then Letter Recognizer.
2. Write a letter in the box — it will automatically be converted to typed text on the screen.

For specific instructions, open Letter Recognizer and tap the question mark icon next to the writing
area.
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To use Block Recognizer:

With Block Recognizer you can use the stylus to input character strokes similar to those used on
other devices.

1. Tap the arrow next to the Input Panel button and then Block Recognizer.
2. Write a letter in the box — it will automatically be converted to typed text on the screen.

For specific instructions, open Block Recognizer and tap the question mark icon next to the writing
area.

To use Transcriber:

With Transcriber you can write anywhere on the screen using the stylus just as you would on
paper. Unlike Letter Recognizer and Block Recognizer, you can write a sentence or more of
information. Then, pause and let Transcriber change the written characters to typed characters.

1. Tap the arrow next to the Input Panel button and then Transcriber.
2. Write anywhere on the screen.
For specific instructions, open Transcriber and tap the question mark icon next to the writing area.

To select typed text:

1. Drag the stylus across the text you want to select.

2. Format or edit text by tapping the command on the Edit menu or by tapping and holding the
selected words until the pop-up menu appears.
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Writing on the Screen

40

To write on the screen, write the same way do on paper. The text can be edited, formatted or
converted at a later time.

To write on the screen:

« To switch to the writing mode, tap the Pen button. Lines will appear on the screen to help you
write.

-

New Edit Tools = | E|4

Tap the Pen button and use
your stylus like a pen.

@ Note Not all programs that accept writing feature the Pen button. Refer to that program’s

documentation to find out how to switch to writing.

To select writing:

If you want to edit or format writing, you must select it first.

1. Tap and hold the stylus next to the text you want to select.

2. At the moment the red circles of the pop-up menu appear, drag the stylus across the text you
want to select without lifting.

If you accidentally write on the screen, tap Edit, then Undo and try again. You can also select text

by tapping the Pen button to deselect it and then dragging the stylus across the screen.

You can cut, copy, and paste written text in the same way you work with typed text: tap and hold

the selected words and then tap an editing command on the pop-up menu, or tap the command on

the Edit menu.
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To convert writing to text:

DRAFT

» Tap Tools and then Recognize.

If you want to convert only certain words, select them before tapping Recognize on the Tools

menu (or tap and hold the selected words and then tap Recognize on the pop-up menu). If a word
iS not recognized, it is left as writing.

e
#E! '
=t

4% 9:40
F Y

Motes

!
x
<
P
B

RNV

Cut
— Copy

NV

report!

Paste
—1 Clear

Recognize

Alternates...

1 |

Mew Edit Tools I@

E|* New Edit Tools &

|«

Select the text you want

to convert and tap Recognize on the

pop-up menu.

text.

The writing is turned into
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If the word conversion is incorrect, you can select an alternative word by tapping and holding down
on the wrong word. On the pop-up menu tap Alternates and browse the list. Either tap the word
you want to use, or tap the writing at the top of the menu to return to the original writing.

{1 | Notes % 9:55
s

T—r 12 AN / ]
Tap to return to your

5{% fo 0 /Q TI original writing.

report!
Report! Or, tap the word you want

to use.

-

New Edit Tools |(=1| E|4

For best recognition:
» Write neatly within the lines and draw descenders below the line. Write the cross of the “t”

and apostrophes below the top line so they aren’t confused with the word above. Write
periods and commas above the line.

 Using the Tools menu, increase the zoom level to 300%.

» Write the letters of words close together and leave big gaps between words.

* Any changes made to a word after you attempt to recognize it (such as changing a “3" to an
“8”) will not be included if you attempt to recognize it again.

@ Note Hyphenated words, foreign words that use special characters such as accents, and some
punctuation cannot be converted.
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Drawing on the Screen

Draw on the screen in the same way that you write on it. The only difference is how the items are
selected and edited. For example, drawings can be resized - writing cannot.

To create a drawing:

« A drawing box will appear when you cross any three ruled lines on your first stroke.
Subsequent strokes in or touching the box become part of the drawing. Drawings that do not
cross three lines will be considered writing.

The drawing box indicates

O ] the boundaries of the drawing.

0

4

New Edit Tools [= | E|*

Pen button.

@ Note You may want to change the zoom level so that you can more easily work on or view your
drawing. Tap Tools and then a zoom level.

To select adrawing:

If you want to edit or format a drawing, you must select it first.

» Tap and hold the stylus on the drawing until the selection handle appears. To select multiple
drawings, deselect the Pen button and then drag to select the drawings you want.

You can cut, copy, and paste selected drawings by tapping and holding the selected drawing and
then tapping an editing command on the pop-up menu, or by tapping the command on the Edit
menu. To resize a drawing, make sure the Pen button is not selected, and drag a selection handle.
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Recording a Message

Any program where you can write or draw on screen, you can also record a message. In
Calendar, tasks and Contacts, you can include a recording in the Notes tab. In the Notes program,
you can either create a stand-alone recording or include a recording with a written note. And, with
the Inbox program a recording can be added to an e-mail.

When recording a message during data communication, hold the device keeping distance from
your body as shown in the illustration on page 61.

To create arecording:

Hold the device’s microphone near your mouth or sound source.

N

Press and hold the Record button (on the left side) until it beeps.

w

While holding down the button make the recording.

»

Release the button to stop recording and two beeps will sound. The new recording appears in
the note list or as an embedded icon.

@ Note Tapping the Record button on the Recording toolbar can also make a recording. To end

recording, press the Stop M button.

To play a recording, tap it in the list or tap its icon in the note.

{3 |Notes ¢ 0:47
77 a

- Indicates an embedded

&
Ly .
recording.

Quote
from Adam

Tap to begin recording.

- [— ol

New Edit Tools =]~ =

Tap to show or hide
the Recording toolbar.
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Using My Text

My Text quickly inserts preset and frequently used messages into the text entry areas of Inbox or
MSN® Messenger. To insert a message, tap My Text and select a message.

l.fij'|r-15w Messenger < 1:58 @

Hi. Zan you meet ak 2:007

I hawve another appointment scheduled For 2:00,
buk arm availal

Yes.

Mo,

I can't talk right now.
I'll be right there.

I'm running late.

| 3=t messagg
Yhere are you?
123|1 (2 ]3]

Hi.
Tablq|w]e
caPlals Goodbye.
Shift| z [ = Call me later.

ctiaii|~ [y Ilove my Pocket PC!
Tools Chats |My Text .,j. |E -

—[¥]

|

‘]

Tap to select a prewritten
message.

@ Note You can add text after inserting a My Text message.

To edit a My Text Message, tap Edit My Text Messages in the Tools menu. Select the message
you wish to edit and make the changes. Tap OK in the upper right corner to complete the change.
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Finding and Organizing Information

The Find feature quickly locates information:

46
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* From the menu, tap Find. Enter the text you want to find, select a data type, then tap Go.

é/} Note To quickly find information that is taking up storage space on your device, select Larger

than 64 KB in Type.
File Explorer can also find files on your device and organize them into folders. To access from the

fwj menu, tap Programs, then File Explorer.

Tap to change folders.

File Explorer

My Device -

MName = Select the sort order

=1 My Documents

for the list.

[==1Program Files
Storage Card
=1 Temp

=1 Windows

Tap the folder name
to open it.

Refresh

¥Yiew All Files

Paskte

Mew Folder

Paste Shortcut

Tap and hold to create

a new folder.

Tap to display the path entry

[ l
Edit Open |« |L]|[®] /4

file of the network.

screen for opening the shared
E|*

| Tap to display the contents of the Storage Card.

Tap to display the contents of the My Device.

@ Note To move files in File Explorer, tap and hold the item you want to move then tap Cut or

Copy. Go to the file where you want to move the document and tap Paste on the pop-up

menu.
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Customizing Your Device

Adjusting the settings and installing additional software can customize your device.

Adjusting Settings

Settings can be adjusted by tapping , Settings, and then the Personal or System tab located
at the bottom of the screen. The following settings or the like can be adjusted:

* Clock:
e Menus:

* Owner Information:
« Today:

* Buttons:

* Remove Programs:
» Password:

* Front Light:

* Power:

* Memory:

To change the time or to set alarms.

To customize what appears on the
menu from the New button.

fwj menu, and to enable a pop-up

To enter your contact information.

To customize the look and the information that is displayed on the
Today screen.

To assign your favorite program to the program button.
See the following pages.
See the following pages.
See the following pages.
See the following pages.
See the following pages.
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Adding or Removing Programs
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Programs installed on your device at the factory are stored on ROM (read-only memory) and
cannot be removed or accidentally lost. ROM programs can be updated using special installation
programs with a *.xip extension. Any programs and files added after factory installation are stored
in RAM (random access memory). As long as you have enough memory, you can install any
program created for your device. To find software for your device, visit the Pocket PC website at
http://www.microsoft.com/mobile/pocketpc.

@ Note If you update ROM programs using special installation programs with a *.xip extension,

do not use the backup data which you made before updating ROM programs.

To add programs using ActiveSync®:

You'll need to install the appropriate software for your device on your computer before installing it
on your device.

1. Determine your device and processor type so that you know which version of the software to
install. Tap , then Settings. On the System tab, tap About. In the Version tab, make a note
of the information in Processor.

2. Download the program to your computer (Or insert the CD or disk that contains the program
into your computer). You may see a single *.xip, *.exe, or *.zip file, a Setup.exe file, or several
versions of files for different Pocket PC types and processors. Be sure to select the program
designed for the Pocket PC and your device processor type.

3. Read any installation instructions, Read Me files, or documentation that comes with the
program. Many programs provide special installation instructions.

4. Connect your device and your computer.
5. Double-click the *.exe file.

« If the file is an installer, the installation wizard will begin. Follow the directions on the screen.
Once the software has been installed on your computer, the installer will automatically
transfer the software to your device.

« If the file is not an installer, you will see an error message stating that the program is valid but
it is designed for a different type of computer. You will need to move this file to your device. If
you cannot find any installation instructions for the program in the Read Me file or
documentation, use ActiveSync® Explore to copy the program file to the Program Files folder
on your device. For more information on copying files using ActiveSync®, see ActiveSync®
Help.

Once installation is complete, tap fwj Programs, and then the program icon to switch to it.
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To add a program directly from the Internet:

1. Determine your device and processor type so that you know which version of the software to
install.

Tap fwj then Settings. On the System tab, tap About. In the Version tab, make a note of the
information in Processor.

2. Download the program to your device straight from the Internet using Pocket Internet Explorer.
You may see a single *.xip, *.exe or *.zip file, a Setup.exe file, or several versions of files for
different device types and processors. Be sure to select the program designed for the Pocket
PC and your device processor type.

3. Read any installation instructions, Read Me files, or documentation that comes with the
program. Many programs provide special installation instructions.

4. Tap the file, such as a *.xip or *.exe file. The installation wizard will begin. Follow the directions
on the screen.

To add a program to the Start menu:

Tap , Settings, Menus, the Start Menu tab, then the check box for the program. If you do not
see the program listed, you can either use File Explorer on the device to move the program to the
Start Menu folder or use ActiveSync® on your computer to create a shortcut to the program and
place the shortcut in the Start Menu folder.

» Using File Explorer on the device: Tap fwj Programs, File Explorer, and locate the
program (tap the folder list, labeled My Documents by default, then My Device to see a list
of all folders on the device). Tap and hold the program and tap Cut on the pop-up menu.
Open the Start Menu folder located in the Windows folder, tap and hold a blank area of the
screen, and tap Paste on the pop-up menu.

The program will now appear on the menu. For more information on using File Explorer,
see “Find and Organize Information,” on page 46.

» Using ActiveSync® on your computer: Use the Explorer in ActiveSync® to explore your
device files and locate the program. Right-click the program, then click Create Shortcut.
Move the shortcut to the Start Menu folder in the Windows folder. The shortcut now appears
on the fwj menu. For more information, see ActiveSync® Help.

To remove programs

* Tap .'E;:F"
If the program does not appear in the list of installed programs, use File Explorer on your device to
locate the program, tap and hold the program, and then tap Delete on the pop-up menu.

, then Settings. On the System tab, tap Remove Programs.

49



Chapter 2: Basic Skills

Setting Password
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Protect data and settings by setting a password that will be requested every time the power is

turned on.

1. Tap [, then Settings. On the Personal tab, tap Password.
2. Select the type of password you would like to use.

£F|settings

Password

(@) No password

Prompt if device unused
Far

O Simple 4 digit password
O Strong alphanumeric password

— Your password must be four numerals.

Your password must be at least seven
characters long and contain a combination
of uppercase letters, lowercase letters,

numerals or punctuation.

Password: |

_|7

J_ Select how long your device must be
turned off before the password is required
to use your device.

— Enter the password.

E|‘

3. Enter a password and tap OK.

4. Tap YES on the confirmation screen. The password is saved and the screen returns to the

Personal tab screen.

DRAFT

@ Note Record your password in a safe place. If you wish to change your password you will have
to know the existing one to access the Password setting screen. If you forget your
password you will have to initialize the device, which deletes all stored data and settings.

If the power is off, you will not be able to answer or make a phone call without entering

your password.

You can automatically receive a call when the Auto-Answer is activated. However, you

cannot disconnect without entering the password.
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Setting the Front Light

1. Tap fwj then Settings. On the System tab, tap Front Light.
2. Set the Front Light.

FrontLight

Check and select when you want front light to
On battery power: automatically turn off.

Warning: Using frontlight while on batkery
power will substantially reduce batkery life,

Turn off Fronklight if =

dewice is nok used for

— Sets the time that elapses until the front light
On external power: automatically turns off.

Turn of f Frontlight if .
I—T—l device is nok used For —

Automatically turns the front light off when the
AC Adapter (external power) is in use.

Brightness Level: |['-"|E|:| Bright ""I—

adjust Power sektings bo conserve power, Tap to select brightness level. If Power Save is
activated, the front light turns off.
E|*

3. When finished, tap OK.

51



Chapter 2: Basic Skills

Setting Power

To confirm and control power usage:

1. Tap [
2. Set Power Options.

.'E:'-F" Settings

Power

Main battery: Lilon

Battery power remaining:
Iil 100%

On battery power:

Turn off device if not

used For |3 rninutes --|

On external power:

Used For |5 minLtes v|

Q Turn off device if not

Bumake i program buktons or SEMD butkan
pressed when suspended,

Adjust Erontlight settings to conserve power,

E|“‘

3. When finished, tap OK.

52
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, then Settings. On the System tab, tap Power.

Displays remaining battery power.

When the AC Adapter is used, the battery
charging mode is displayed, but the remaining
battery power is not displayed.

When checked, automatically turns off when
the device hasn't been used for a user-set
amount of time.

Sets the time that elapses until the power
automatically turns off.

Automatically turns the power off when the
AC Adapter (external power) is in use.

Check to turn the power on if you press the
program buttons or the SEND button when
the device is off. To prevent the device from
being turned on when the button is pressed
accidentally, clear the checkbox.



i i DRAFT
Chapter 2: Basic Skills

Setting Memory

Memory for the device is automatically managed. You can adjust data storage memory and
program running memory, and confirm the amount of free space on a storage card.

To change Memory allocation:

1. Tap , then Settings. On the System tab, tap Memory to display the Memory setting screen.

L.ﬂ?‘:.jrj" Lettings

Memory

Memary is managed aukomatically, To
kemporarily adjust the allocation of storage
and program memory, move the slider,

Taotal main mermory 21.40 MB

Storage - Program Slider.
[ ——— |

|II 1 1 1 1 I I 1 1 II.I 1 1

allocated: 15,71 ME  Allocated: 15,69 MB Free space of the Program memory.

Inuse: [ 0,57 MB Inuse: 7,95 MB
Free: [15.14 MB Free: 7.74 MB

Free space of the Storage memory.

Main | Storage Card | Running Programs

Eemove programs ko free storage memary,

Eind larae Files using storage memary,

E|“

2. Drag the slider widthwise to adjust the memory allocation between Storage and Program.
3. When finished, tap OK.
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To confirm usage status of a storage card:
1. Tap fwj then Settings. On the System tab, tap Memory, then the Storage Card tab on the
bottom.

fwj Settings

Menmory

Total storage card memory: 20,54 MB ———— Capacity of a storage card being inserted.

Inuse: 20,22 MB Free: Q.21 MB

r | |

|5t|:|rage Card -|

Free space.

Capacity in use.

Main | Storage Card | Running Programs

Eemove programs ko free storage memory,

Eind large files using starage memory,

B |

2. When finished, tap OK.

To release memory:
If memory is approaching full capacity, you can free up space by:
 Transferring data to a storage card or to your computer and delete from your device.

* Deleting unnecessary files and programs.
* Quitting the program currently in use.

@ Note For more detailed information on operation method or the releasing memory, tap then
Help.
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The phone portion of this device is designed to be used with an earpiece which is supplied, or as a
speakerphone. Unlike conventional cell phones, it is not designed to be held against the head in
conversation without the use of a supplied authorized earpiece. Any other hand held use against
the head without an earpiece is not warranted. Such unauthorized use of the phone, without an

earpiece or as other than a speakerphone, has not been tested by the FCC for RF exposure
compliance.

Using Phone Function

Launching Watcher

A program named Watcher is used for the phone functions on your device. When Watcher is
launched, the screen will automatically switch to the Watcher screen when a call is received, even
if you are in another program.

1. Turn the Radio Standby Switch ON. Your device power is on and Watcher is launched. When

Watcher has completed launching and the main screen (see next page) is displayed, you can
use phone functions.

@ Note When Watcher is launched, a status icon of Watcher is displayed on the right part of the
command bar of the Today screen.

When you do not place a call or use your device, press the Power button to turn off the
power of the main unit.

If the Radio Standby Switch is ON, the Watcher screen appears automatically when a call
comes in, even if the main unit is turned off.

Ending Watcher

1. Turn the Radio Standby Switch OFF. Watcher will turn off and the screen will disappear.
Do not quit Watcher during a call or communication.

é} Note After Watcher is OFF, phone functions will not work even if the power of the device is on.
If you turn the Radio Standby Switch OFF while the power of the device is OFF, Watcher
will turn off when the device is turned on again.
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Main Screen

B DATA tab

In Use Indicator

Receiving Signal Strength Indicator
The number of lines indicates the
received Signal Strength.

Coverage Indicator Icons

Receiving Signal Strength/No Service Indicator

Status box displays information about
the current call and any status messages.

_I— Indicator icons

Connection Drop-List
Dial-Up |#F"?‘?‘ I Phone number of the connection destination
| Zanneck | ' II Shortcut to Dial-up Manager
Veri O miss
Data | VOICE 7!— Data/Voice Controls Tab Selection
Tools Admin B~
M VOICE tab

Call progress indication.
gt Incoming or Outgoing number and
15| Watcher cross-referenced Phone Book name

— Phone Book

Volume up and down, and
Microphone Mute

ScratchPad
SEND button

END button

CLR button
Dial-pad

DATA
Tools Admin E|*
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Icons

Icons of the display indication

LT Auto-Answer incoming Voice Calls
= Displayed when there is an unread message. When a message set to
High Priority is received, the icon flashes.
¥ B Notification that one or more voice mail messages have been received

Notification that there were one or more Missed calls

The Earphone is connected to the device.

B E

When receiving a call, the ringer tone sounds and the vibrating alert
vibrates simultaneously.

-
EXT
b

When receiving a call, the ringer tone does not sound but the vibrating
alert vibrates.

When receiving a call, the ringer tone does not sound and the vibrating
alert does not vibrate.

Enhanced Voice Privacy is available during a call.

V.42bis is available.

Displayed when the 1x Service can be used.

@R S

Displayed when roaming

Icons of the modem

Displayed when an error occurs during a call.

Displayed during data transfer.

Displayed during high speed data transfer.

Displayed during voice calls.

w07 O 2

Displayed when modem is not used.
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If you press the SEND/END button while the Watcher program is open, the VOICE tab of the
Watcher screen will be displayed, even if you were not in the Watcher program at that time. Once
the Watcher screen is displayed, the SEND/END button on your device can be used for the same
operations of the SEND/END button of the screen. Each button on the VOICE tab screen can be
used for the various operations according to the situation.

SEND | Place a call to the phone number | Answer a call. When receiving a call from the new
displayed on the screen. When party, answer the call. Also, you can
the number is not displayed on switch to the Three-Way calling.
the screen, a call is placed to the
last number dialed.

END | Delete all entered numbers at one | Reject the incoming | End all calls including the three-way
time. call. calling.
CLR | Delete entered numbers one by Mute the ringer Delete messages or entered numbers
one or tap and hold CLR button tone. one by one. Tap and hold the CLR
to delete them all at one time. button to delete them all at one time.
0-9, Enter the number you wish to If Any-key Answer is | With the current call being kept, the
*,# | call. Tap and hold the Speed Dial | set, you can answer | number you entered is displayed on the
location number for one-touch a call by tapping screen.
dialing of that number. any of these keys.

Navigation Button and Program

If you press the navigation button of your device when the Watcher screen is displayed, the
programs stored will open.

Speed Dial

Phone Book

Mobile Messenger

Top :

The Phone Book is open.

Bottom : The Mobile Messenger is open.

Right :
Left:

Call Log

The Call Log is open.
The Speed Dial is open.
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Tools menu

DRAFT

You can select the following items from the Tools menu at the DATA and VOICE tabs:

.*'ﬂ '| watcher

=

Ready to Conneck

SIERAA WIHELESE
Mobile Messenger...

Phone Book...
Speed Dial...
Call Log...

Dial-Up Manager...

KeyGuard
veriyon. s
Options... VOICE
Tools| Admin E|*

Admin menu

Displays the Mobile Messenger screen.

Displays the Phone Book screen from
which stored numbers can be called.

| Displays a screen for storing phone numbers

at numbers 1 to 9 on the dial pad.
Displays a list of incoming calls, outgoing calls,
missed calls.

_|— Displays the Connections setting screen.

Turn on the KeyGuard function to protect against
accidental operation.

Displays the Options screen for changing or

establishing various settings (Security, Sounds, etc.).

You can select the following items from the Admin menu at the DATA and VOICE tabs:

L.:'f;—?“ Watcher

(3]

E---.

Ready to Conneck

SIERA&A WIRELESE

ODOD® ™
ﬁ About Watcher...

— | Activation Wizard...

Tools [Admin

E|‘

Displays information about Watcher.

Use this function when the phone functions
of device are not activated.
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Talking on the Phone
Here explains how to use your device when you talk on the phone.

To use the Microphone and Speaker of your device:
You can use the Microphone and Speaker of your device to talk on the phone.

To use the Earphone Microphone:
You can use the supplied Earphone Microphone by inserting it into the headphone jack to talk on
the phone.

For the Earphone Microphone, see page 24 of Chapter 2.

To use the Audio Remote Controller with Microphone:
You can use the Audio Remote Controller with Microphone connected to a separately sold
headphone, by inserting it into the headphone jack to talk on the phone.

For the Audio Remote Controller with Microphone, see page 25 of Chapter 2.

You can use the SEND/END button of this controller as SEND button by releasing it immediately
after pressing, and as END button by pressing and holding.
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Watcher must be launched in order to place a call.

Dialing
1. On the VOICE tab screen, enter the phone number of the other party using the dial-pad.
‘,. appears when the call is connected.

.f-rj Watcher il 4= 12:24 9

Call is connected

Tools Admin E|*

@ Note If you make a mistake when entering the phone number, tap the CLR button to clear the
last digit. Tap the END button to clear the entire number.

Ending a Call

1. Tap the END button to end a call. When the call is ended, the call time disappears from the
display.
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Dialing from the Phone Book

1. Eithertap on the VOICE tab screen or tap Phone Book on the Tools menu.

2. Once the Phone Book screen is displayed, select the phone number you wish to call, then tap
Dial on the command bar. The number is dialed and the Phone Book screen closes.

1,,. appears when the call is connected.

é} Note Dial can also be selected from the pop-up menu that appears when you tap and hold the
other party’s phone number. In addition, calls can also be placed by tapping the desired
phone number twice continuously.

Speed Dialing

1. On the VOICE tab screen, tap and hold the corresponding speed dial location number of the
number you wish to call for at least one second. The phone number stored at that location is
dialed.

@ Note Select the number stored for speed dialing, then tap the SEND button, you can place a
call.

For details on the speed dial function, see Speed Dial (page 70)

Dialing from the Call Log

1. Tap Call Log on the Tools menu.

2. Atthe Call Log screen, tap the number you want to dial and select Dial from the File menu or
press center of the navigation button. The number is dialed and the Call Log screen closes.

@ Note You can also place calls by tapping and holding the number you want to dial and
selecting Dial from the pop-up menu. For details on the Call Log screen, see Call Log
(page 71).

Redialing
1. Tap the SEND button on the VOICE tab screen to call the last number dialed.

é} Note The redial function does not work when there has been a missed call.
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Receiving a Call
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When a call is received, your device alerts you with an audible alert sound, the flashing indicator
and the vibrating alert, depending on which alert mode is set.

1. Tap the SEND button on your device or the screen to answer the call.
When a call is received, you can mute the ringer tone by tapping, the CLR or Volume button.

About Any-key Answer:

*  When Any-key Answer has been set, you can answer a call by tapping any button other than
the END, CLR or Volume button.

Also, you can answer the call using 4 program buttons on the main unit.
* Any-key Answer can be set at the Voice tab in Options. For details, see page 77.

About Caller ID:

When a call is received from the caller whose number is stored in the Pocket Outlook Contacts list,
the name and the phone number will be displayed.

If the call is from the caller who is not in the list, “Unknown” will be displayed.

#8| watcher Yil €% 1225 €3

Yoice Call From
[Tnkrnowt)

SIERR& WIRELESEB

Tools Admin E|*

@ Note When you tap the END button during an incoming call, the call is rejected and missed call
icon MiC appears.
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Volume Control

You can change the ringing setting by using the Speaker Icon Button. You can adjust the volume
during a call by using the Volume Buttons.

Tap to adjust the ringer volume by tapping here.

l.:'Er f| Watcher

Yolume Appears when Volume Buttons are used.

@ — Speaker Icon Button

SIERRA WINELESE Volume Buttons

Tools Admin E|*

Speaker Icon Button

The setting changes each time you tap the Speaker Icon button.

In standby mode, the setting options are “Ringer Only”, “Ring and Vibe”, “Vibrate Only”, and “Silent
Mode” (Ring and Vibe Off).

During a call, the setting switches between “Sound on” and “Mute”.

Volume Buttons

When you tap the Volume buttons, a volume bar appears on the screen to indicate the volume
level (6 levels excluding Mute).

You can also change the volume on the Headset Volume at the Sounds tab of the Options .
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Call Waiting

When another call is received while you are talking on the phone, you hear a call waiting tone and
“Call Alert From” appear on the display.

Tap the SEND button at this time to put the party you were originally talking to on hold and
switch to the new party. When it is switched to the new party, the information of the other party
will not be displayed.

The party switches each time you tap the SEND button.

Call Forwarding

Call Forwarding is a service which transfers your incoming calls to another phone number.

Please contact your service provider about this feature.

Three-Way Calling

This feature allows you to talk to two people at two different phone numbers at the same time. This
is a service dependent feature. Please contact your service provider about this feature.

1.
2.

When connected to one other party, tap the SEND button and dial the second party’s number.

When the call to the second party is connected, tap the SEND button to talk to both parties at
the same time.

Tap the END button to disconnect both parties.

Voice Malil

[ 51 appears on the display when you have new voice mail.

1.
2.

Tap [ 3.
On the confirmation dialog screen, tap YES. The phone connects to your voice mailbox.

The voice mailbox phone number can be set at the Voice tab in Options. For details, see page
77.

Digital Numeric Page

66

When Digital numeric page is received, “Numeric Page: XXX-XXXX" appears on the screen. XXX-

XXXX is numerical.

The received “Digital numeric page” is saved as SMS in Inbox.

Open the Digital numeric page in the Inbox, and select Call back Sender, you can place a call to

the number.
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Missed Call

M appears if you receive a call that you do not answer. When there is one missed call, “1 new
Missed Call(s)” is displayed. When there are two missed calls, “2 new Missed Call(s)” is displayed.

Tap the END button to turn off the missed call message.

Calling Missed Calls Back

You can call the caller back.
When there is one missed call, tap the SEND button to call the caller back.
If there are more than one missed calls, tap the SEND button to call back the last missed call.

The Call Log screen appears when M is tapped. You can use this to select a party who has called
and call that party back. For details on the Call Log function, see page 71.

@ Note If the caller’ number is not notified, you cannot call back.

Link Dialing
When Link Dialing is set, you can place the calls requiring multiple number inputs in a sequence of
continuous operations.
This is convenient for example for using your home answering machine while you are out.
Link Dialing is set when storing phone numbers in Contacts in Pocket Outlook.

Link Dialing Storing
1. Atthe Contacts, start up a screen for a new party or open the screen for the party you want to
change.
Enter the phone number.
After the phone number, enter uppercase “L” or lowercase “I", then the next number.
To enter more numbers after this, repeat steps 3.
Once all the numbers have been entered, save, then start up Phone Book in Watcher.

o gk wDn

Tap Refresh on the command bar. The set number is read into Phone Book, and calls can now
be placed from there using Link Dialing.

Example: 604-323-%%xx L 9837%%x | 98324«
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Emergency Dialing

Emergency calls can be placed as long as the power is on and there is a signal, even if the phone
is not registered, is not activated or if the KeyGuard mode is activated.

1. Enter “911" from the dial pad, then tap the SEND button.
2. Tap the END button to end the call.

@ Note When the emergency call number is stored in the speed dial memory, you place the
emergency call by pressing a single key. This function does not work in the KeyGuard
mode.

The emergency call number varies from region to region.

Phone Book

The Phone Book screen displays a list of the names and numbers stored in Contacts in Pocket
Outlook. The Phone Book screen can be used to place calls, and numbers added to Outlook can
easily be read into the Phone Book.

Tap Phone Book on the Tools menu to display the Phone Book screen. The Phone Book screen
can also be displayed by tapping on the VOICE tab screen.

£j| Watcher Yil 4¢ 10:47
#ab | cde | Fah | ik [Imn Jopg | rst Juwe (w2 ]— Tap the first letter of the name you want to
Lasky, EFic N fjisplay. The first name starting with that letter
A ———— — is displayed at the very top.
EEht e (Example: When you tap “Imn”, the first name
works (B04) 233-%%xx starting with the letter “I” is displayed
- Home: (B04) 575- at the very top.)

“Mobile: (604) 341-% %%
“vwork Fa (604) 232-2558 L2830 % %%
Lvnn, Margan
Mason, Gary
Micholls, Mike
C'connar, Leigh
Pask, Mauris
Raymond, Barry
Scokk, Harry
Tacker, Ann

Tracy,|Matk
Lt dil ] Ok

Dial Refresh E-|—-—

Tap to dial the selected phone number.

Tap to read in the data from Contacts
and refresh the Phone Book.

@ Note Names and phone numbers cannot be added directly to the Phone Book screen.
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KeyGuard Lock

Use this function to guard against accidentally inputting numbers, or other unwanted key presses,
etc.

1. Tap KeyGuard on the Tools menu. The KeyGuard mode turns on and “KeyGuard enabled”
appears on the screen.

2. Tap KeyGuard on the Tools menu again to turn the mode off.

@ Note When the KeyGuard mode is on, the operations that are possible are turning the
KeyGuard mode off, selecting the Tools/Admin menu, placing emergency calls, and
receiving incoming calls by tapping the SEND button.

Scratch Pad

1. Tap @ Using the scratch pad to take simple notes or to note a phone number during a call,
etc.

l.:'fr;—?" Watcher

ScratchPad Tap to close ScratchPad.

When starting up at the next time, the same
contents as the previous ones are displayed.

testing scrathp

Tap to delete all the notes
you have entered.

| SIERRA WIRELESE
123i1‘2 3i4i5 6|7 E|EI|EI| = |4

Tab[a[wle[r[t[¥[u]i]o]p
Enplalslulflglhlllklll | ]

shift[z[x[c[v[b[n[m].]. |;|,,,_|
ctijair] " [v] [L][1]e]=
Tools Admin |E*
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Speed Dial
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Storing phone numbers in the speed dial memory for numbers 1 to 9 on the dial pad makes it

simpler to call those phone numbers.

Storing

1. Tap Speed Dial on the Tools menu or press left on the navigation button. The names and
phone numbers stored in the speed dial locations appeatr.

2. Tap the section next to the dial pad number at which you want to store a speed dial number.

The Phone Book screen appears.

3. Select the phone number you want to store, then tap Add on the command bar. The selected
name and phone number appear next to the dial pad number. (Tap the desired dial pad number
to call the phone number stored at that dial pad number.)

4. Tap OK.

YWatcher

il 4¢ 10:45 (6

Lasky, Eric
B04-222- ®xx2x

Raymond, Barry
B04-190- 2222

Pask, Mauris
S09-206- 33 %3

O'connar, Leigh
B04-435- €€k

Mason, Gary
Bo04-665- 336 % %

Wilsom, Pat
S09-725- 3363 %

Tracy, Matk
B04-120- ek

Micholls, Mike
B04-469- 33 % %

Scokk, Harry
B04-477- €3k

E|‘

Clearing

Tap to call to the phone number in the
right section.

1. Tap Speed Dial on the Tools menu or press left on the navigation button. The phone number

section storing Dial pad number appears.

2. Tap and hold the section on the right side of the dial pad number which you want to clear the

entry.

3. Tap Clear Speed Dial Entry on the pop-up menu which is displayed. The entry is cleared and

“<Unassigned>" appears.

4. Tap OK.
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Call Log

Use the Call Log screen to display a list of incoming, outgoing and missed calls. The lists include
such information as the party that has called, the party you have called, the call time, etc. Calls can
be made directly from this list.

Tap Call Log on the Tools menu or press right on the navigation button to display the Call Log

screen.

3| wakcher Vil 4¢ 332 (Y
= | From T

B 123-456-% % %%
Bt 125-455-%%xx F45-670- %% %%
L 123-456-%x %%
B 123-456-% %% 455-780-3¢3¢ 3 3
Bt 123-450-%% %%
1 | I [»
File Edit ¥Yiew E|*

A pop-up menu displaying the items Delete, Copy Phone Number and Dial appears when you tap
and hold a log item.

Adding Telephone Numbers From the Log

1. Tap and hold on the item you want to add to display a pop-up menu, then tap Copy Phone
Number.

2. Tap fwj then tap Contacts and New. To change the number of a person whose number is
already stored, select that party, then tap Edit on the command bar.

3. Paste the copied phone number into the phone number section.

@ Note Itis not possible to call items marked “Unknown” on the incoming call log or to store such
numbers in Contacts.

Storing Call Log As aText File

1. Tap Save As on the File menu.
2. Name the text file on the Save As screen. Also, you can select a folder or a location storing the
text file.

3. Tap OK.
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Options (Preferences)

Tap Options on the Tools menu to display the Options setting screen. A number of settings
(Sound, Security, etc.) can be made at this screen.

General

— Set the number of minutes after which the
line is disconnected after you end the data
communication.

(A warning message appears before

the line is disconnected if so set at Options.)

Data-Call Inackiviky i 11 |
Timeaout: Disconnect [ ror T1| 1 Select the mode for answering incoming calls.
Incaormin : .
Calls: P.nswe? all calls as Yoice  ~TT™ — Select the number of calls to be retained
. in the Call Log. Calls exceeding this
all Logging: |Iast 100 calls ,1—— number are automatically deleted.
Retain

, When contracting with two NAMs (Number
Active NAM |NF'-M 1 - 123456% %% % "1_ Assignment Modules), you can select to

Profile: use either of the NAMs.
System Select |H'3"""E Preferred "'+— System selection is possible in an area that permits roaming.
Automatic A:  Scans the Priority system, if not found, scans the A-system.
Update System Clock with COMA time Automatic B:  Scans the Priority system, if not found, scans the B-system.
during start-up Home Preferred: Permits roaming if the home service is not found.

L Home Only: Permits only home service.

U e When this is checked, the CDMA network
is used to update the time to the accurate
L time when Watcher is started up.

Check when connecting teletypewriter, etc.
to the headphone jack.

General | Display | SM3S | Security Su:uund4 1|F

Cancel Restore Save E|‘
! |

Tap to save the new settings.

Tap to restore all the settings
to the defaults.

Tap to return to the previous screen
without storing the settings.

These operations function in the same way on the different tab screens.
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Display

Watcher

Warning Messages
1xRTT premium service charge (Far non-
§ gsul:uscril:uersﬁ

§|:|§Data connection losk

] EIF‘ re-assigned

I Check to display the Warning Message while
meeting the conditions on the right part.

izeneral | Display | SMS | Security SDundsl“lP

Cancel Restore Save E|“
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SMS

At the SMS tab, you can set options for short message service like expire timeframe.

74

SM5 Messages:
Expire

D Crhverride
Callback #

Change. ..

Save ko Outbosx automatically

-

Set the dead line to expire received messages.

— Check the checkbox, then tap Change
to display the Callback number entry
screen.

Enter a phone number other than the

one of your own, the number set
here is displayed as a callback number
at the time when a message is sent.

zeneral | Display | SMS | Security Snundsl*‘l"
Cancel Restore Save E|‘

— Set whether or not to store the sent message
in Outbox.

DRAFT
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Security

You can use the Security tab to lock the modem, change the password, etc.

When the modem is locked, most menu functions (Options, SMS, Call Log, etc.) cannot be used.
(The “Unlock Modem” menu can be selected.)

Also, no calls other than emergency calls can be placed, and when a call is received, the caller’s
phone number is displayed “xxx".

Watcher | 4£ 1:14

Lock roderm — Select Never or On power up.

Change Lock Cade. . Tap to change the lock code.
To change the lock code, first enter the
old lock code, then enter the new one.

Lock Modem Mow

L Tap to immediately lock the modem.

igeneral | Display | SMS | Security | Soundq 4| #

Cancel Restore Save E|“
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Sounds

DRAFT

You can use the Sounds tab to set the sounds for incoming calls, voice mail, SMS messages, etc.

Watcher | 4£ 1:15
| Enable
[l Call Waiting Alert
§|Ringﬂ.wav || = ” |
EENE.'W SM3 Message L
I §|r'-.I|:|I:iF':.-'.wav || = || -|-—

E;New Yoicerail

Headset Yalume

I|I"-.I|:|I:iF~;.-'.wav || = ” |
Incoming Call J

Ringer Type [Ringar Only |l

|Ring1.wav || = I |

Min""':1'r~'1a:-:,;}]-:T

Display | SMS | Security | Sounds | Yoice 1|F
Cancel Restore Save E|‘

When a box is checked, the tone is
sounded in that situation.

Tap “>" to test play the set sound.

Tap “...” to display the Open screen for
selecting a sound file. The screen returns
to the previous screen when selecting a file
on the Open screen.

Select a receiving type from “Ringer Only”,
“Ring and Vibe”, “Vibrate Only” and “Ring

and Vibe Off” in the “Incoming Call” section.
You can also select a receiving type with the
Speaker Icon Button on the VOICE tab screen.

Adjust the volume of the conversation.
The volume can also be changed
at the Voice tab.
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\Voice

Set the number of rings after which the auto-answer
function answers the phone. Set Auto-Answer to
answer a call automatically without using hands
while driving.

} °F Set the number of seconds after which to retry when
Auto-Answer a call cannot be connected.

Auto-Retry ||:|FF vi— ’— When this is checked, hyphenation is added automatically
when phone numbers are entered using the dial pad.
&uto-Hyphenation any-key Answer
; ; by pressing any key other than END, CLR and
e L o the volume button. This function does not work

Tone Length |ru:urma| 7'71 in the KeyGuard mode.

Use this to set the length of the tone when numbers,
|_|__| Muke etc., are entered from the dial pad.

When Mute is checked, the tone is not sounded.

When this is checked, incoming calls can be answered

audible Indicators

|_|_—I Minute Alert Service Alert |— When this is checked, a tone is sounded every minute
YaiceMail during phone calls.

| | Change. .. | l— When this is checked, a tone is sounded when calls
are interrupted, when the service area switches from
home to roaming, etc.

|*ae

Display | SM3 | Security | Sounds | Vaice |1 4

Cancel Restore Save E|-—~

Enter the phone number, then tap Change to set the number for checking
your voice mail.
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SMS (Mobile Messenger)

Contact your service provider before using this function.

78

Tap Mobile Messenger on the Tools menu to display the SMS message screen.

When you receive a message, [ appears on the display. The indicator flashes if the received

message is set to high priority.

Tap this indicator to open the SMS screen.

The following is a list of the icons displayed with the SMS function.

' This icon is displayed next to the message in the Inbox or Outbox if the
+ message is set to high priority.
=5 This is displayed when there is a saved message in the Outbox that has
not yet been sent.
—¥ This is displayed when an error occurs during transmission and the
message could not be sent.
== This is displayed when transmission to the network is completed.
o This is displayed when the person who the message was sent to has
received the message.
Messages marked with this check will be deleted when Delete is selected
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Inbox

Received messages are stored in the Inbox.

Watcher | 4% 6:23 @
Y | From Message
O GOD00D0=%%x= This is a kest mess A list of received messages.
[0 ! 600000%xxx Urgent! Call me AS The details of the selected message are
O] ! J—— it F-{E' ket displayed in the section below.
- " Unread messages are displayed in bold.

4 [ I IC
Received: Z/7/2Z00Z 11:00:38 - Displays the time the message was received.
From: 6 00 0 00 2 3636 3¢ [ Displays the number of the sender.
Callback: c04-759-%xxx — L
Priority: Normal Displays Callback number when

| - the sender specified it.
= Displays the status of the Priority which is set.
@ 3 messageis), 1 unread Displays the number of messages stored in
the Inbox and the number of unread messages.

B2 Inbox | ©53 Outbox
File Edit E|a-

]

Tap to display a screen for composing a
new message.

You can select New Message, Forward Message, Reply to Sender and Call back Sender from
the File menu.

New Message: Displays a screen for creating a new message.

Forward Message: Forwards the message as such. When selected, an input screen with no
sending number is displayed.

Reply to Sender: Displays the screen for composing a new message with the sending number
already entered.

Call back Sender: Calls the person who sent the message.
You can select Delete and Delete All from the Edit menu.

Delete: Deletes all the messages with checks in their check boxes.
Delete All: Deletes all the messages in the box, regardless of whether or not they are checked.
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Outbox

Sent and unsent messages are stored in the Outbox.

Watcher

5

Vil 4¢ 6:22 Dy

To

OO0 &E 604780

O 2 A04320%xxx

O ! =¥ 604750%xxx

O ITEE Bl 70 3 3 3

4| [ I I
status Sent =
To: 604759 exx2% | Jent)
Callback: 123-456-%%%x% =
Priority: Urgent — ]
14 | ! b
@ 4 messagels), 1 unsent

T Inboze | 555 Outbio

File Edit E|A

A list of sent or saved messages.
The details of the selected messages are
displayed in the section below.

The icon displayed depends on the
message’s status.

Displays the status of the message (whether
or not it has been sent, whether or not it has
been sent to the network, whether or not the
recipients have received it, etc.).

Displays the destination address.

Displays the Callback number which is set.

Displays the number of messages
stored in the Outbox and the number of
unsent messages.

You can select New Message and Edit Message from the File menu.

Edit Message: Displays a screen for editing stored messages. If the message is edited, the
previous message is overwritten.

You can select Delete and Delete All from the Edit menu.

DRAFT
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Composing New Messages
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1. Atthe Mobile Messenger screen, tap ana on the command bar.

2. Enter the recipient and select Normal or High for Priority. The recipient can be selected from
the Phone Book when To is tapped. (See the following page.)

automatically.

Enter the message, then tap Send. Once the message is sent with no error, the screen closes

If an error occurs (no service, message incomplete, etc.), transfer is interrupted and an error

message appears. Choose whether to resend

the message or save it and try again later.

@ Note Also, you can send Messages by selecting Send from the File menu.
Set whether or not to store sent messages in the Outbox at the SMS tab at Options. You
cannot check whether the recipient has received the message unless this function is set.

Watcher

il 4% 1:39 (D

L H

Charackers Left: 160160

Send

FY

1231 [2[3]4[5]a[7[8]o]0]-[=]
Tabja[wle[r|t|y|ulijo/p[[]]
CaPla[s[d[f[a[h[i[k[1];]"]
shiftz [x [c[v|b[nim|.[.[/][+
ctijai] - [\ ] NEGE
File Edit |Ea

You can select Send and Save from the File menu
Send: Sends the message.

Tap to display the selection screen of
the phone number or address.

The maximum number of characters that
can be entered per message is 160.

Once this number reaches 0, nothing more
can be entered.

Select Normal or High.
Select High to notify the recipient
that the message is urgent.

Save: Saves the message in the Outbox without sending it.

Tap OK when you want to stop the operation while composing a message. A dialog asking whether
or not save the message appears. When you select YES, the message is stored, and when you

select NO, the message is not saved.
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To select the recipient from a list

Use this function to select the recipient’s number from the Phone Book.
1. On the message screen, tap To.

2. Select the recipient from the list, then tap Add. Also, you can select the recipient by tapping it
twice continuously.

3. Once you have selected the recipient, tap OK.

Watcher il 4% 2:33 (DY

Select phone number or address from the list:
Leaver, Daonald
Work: (B04) 233-2% %%
Home: (604) §75-%% %%
- Mobile: (604) 341-%%%%
Wark Fax: (604) 232-33€ 3% | €365
8 F 11501 asaa=a@bbbbb.com

HHIE

Lynn, Morgan | Other than selepting from the list, you can tap
] Add after entering the phone number or address
gdd if Femowve [ to Add them to the Recipients.
Recipients — A recipient can be removed by selecting that
—_ recipient and tapping Remove.
aaaaalbhbbbb. con
G075 D3 3¢ 3 . -
—— Displays the selected recipient.

Zancel Tap to cancel the setting and return to the
E| previous screen.
i

To send messages simultaneously to multiple recipients

Add multiple recipients by repeating the operation of selecting recipients from the list and tapping
Add.

If you are not using the list, messages can be sent to multiple recipients by entering a comma “,” or

" after each number.
Example: 98701 xx%%, 98712xx%*
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Accessing the Internet
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You can access the Internet by selecting “1IxRTT” or “Quick net Connect” from the DATA tab or

using subscribed ISP.

Watcher

E---.

]

Ready to Connect

SIERRA WIHELESER

~ Quick 2 MetsM n

il €4 1:41 €3

- Express Nebwork,

- Quick, 2 NetsM

| Conneck | ﬂ
l\..f"f..
VRO iioss
DatA f VOICE
Tools Admin E|*

High-speed packet service

Connection service allowing smooth connection
to the Internet.

1. Tap the pull-down list and select the desired connection name.

2. Tap Connect to access the Internet using the selected service.
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Using Subscribed ISP

Make the settings required for using your subscribed ISP (Internet Service Provider).
1. Tap Dial-Up Manager on the Tools menu. The Connections setting screen appears.

Vil 44 6:41 (D

Add...

- Ciick 2 MetsM

Properties. ..

Delete

_onneck

Sek As Default

Default Connection |— Cuick 2 Meksm |
Connection Details
Phare |#19788 |
User Mame | 123456****@v2w3g|
Dial s |#19788 |

E|*
2. Tap Add.
3. Enter the required information.
l.%.i" Watcher il 4£ 6:44 @
Conneckion Name Enter the connection name. (Example: ISP name)
Phorne [609%%xx Enter the connection number.

Area Code |E-I:|4 |

|:|Llsel

lse area code

User Mame | EEEEEE] I Enter the connection user name specified by the ISP.

Passward |******** _I_

Save password

Enter the connection password.

Save Zancel
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4. Tap Save. The settings are stored in Connections and this connection can now be selected to
access to the Internet.

Your device will automatically begin connecting. Once connected, you can:

» Send and receive e-mail messages by using Inbox. Before you can use Inbox, you need to
provide the information it needs to communicate with the e-mail server. For specific
instructions, see “Connecting Directly to an E-mail Server,” in Chapter 8.

« Visit Web and WAP pages by using Pocket Internet Explorer. For more information, see
Chapter 7.

» Send and receive instant messages with MSN Messenger. For more information, see “MSN
Messenger,” in Chapter 6.
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Microsoft® ActiveSync® synchronizes the information on your computer with the information on your
Pocket PC. Synchronization compares data between the two and updates both with the most
recent information. For example:

» Keep Pocket Outlook® data up-to-date by synchronizing your device with your computer’s
Microsoft® Outlook®.

» Synchronize Microsoft® Word and Microsoft® Excel files between the two. Files will be
automatically converted to the correct format.

@ Note Use ActiveSync® options to select which types of information to be synchronized.

With ActiveSync®, you can also:

« Back up and restore your device data.
« Copy (rather than synchronize) files between your device and computer.

« Control when synchronization occurs by selecting a synchronization mode. For example, you
can synchronize continually while connected to your computer or only when you choose the
synchronize command.

« Select which information types are synchronized and control how much data is synchronized.
For example, you can choose how many weeks of past appointments you want synchronized.

Before you begin synchronization, install ActiveSync® on your computer from the Thena Companion
CD. For more information on installing ActiveSync®, see your Quick Start Card. ActiveSync® is
already installed on your device.
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After installation is complete. The ActiveSync® Setup Wizard will:
1. Help connect your device to your computer
2. Set up a partnership to synchronize information between the two devices
3. Customize the synchronization settings.

Synchronization automatically begins when you finish using the Wizard. After this initial
synchronization, view your device’s Calendar, Contacts and Tasks. Everything stored in Microsoft®
Outlook® on your computer should now be on your device. Disconnect the device from your
computer and you're ready to go.

To initiate ActiveSync® on your device, tap fwj and then tap ActiveSync.

For information about using ActiveSync® on your computer, see ActiveSync® Help in the ActiveSync
program.

7| ActiveSync 4% 11:35 €3
Pocket PC

(¥ | |
Connected o View connection status.

Tap to connect and synchronize.

| Tap to stop synchronization.

@ Sync 9 Stop

Synchronize with PC
Last Sync: 2/15/02 10:52 AM

—~— View synchronization status.

Tools E|*

L—— Tap to synchronize via IR or
change synchronization settings.

For more information about ActiveSync® on your device, switch to ActiveSync®, tap , then tap
Help.
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Microsoft® Pocket Outlook® includes Calendars, Contacts, Tasks, Inbox and Notes which can be
used individually or together. For example, e-mail addresses stored in Contacts can be address
e-mail messages in Inbox.

ActiveSync® synchronizes information in Microsoft® Outlook® or Microsoft® Exchange on your
computer with your Thera Pocket PC, comparing changes made on both and updating each of
them with the latest information. For information on using ActiveSync®, see ActiveSync® Help on

the computer.

Calendar: Scheduling Appointments and Meetings

90

Use Calendar to schedule appointments, including meetings and other events. You can check your
appointments in one of several views (Agenda, Day, Week, Month, and Year) and easily switch
views by tapping one of the 5 view icons at the bottom of the screen or by pressing the Calendar
Program (button#1 on front of your device).

To access the Calendar, tap fwj then Calendar. Or, press the Calendar Program button on the
front of the device.

L.{-.i? Calendar

Feb 03, 02 EM ITWTES Ej—I—r— Tap to go to today.

Working at home

Lunch w/ Adam Tap to display or edit

1:-'_":|_||_||:I-1 :|:||:||:| I::'::I:IrrlEfr' '::EIFE:J the appointment details.

Status Meeting
3:00p-4:00p

anaw Tools E E @ E|‘

Tap to switch between the 5 views
(Agenda, Day, Week, Month and Year).

Tap to create a new appointment.

@ Note Tap Options on the Tools menu to customize the Calendar display.
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To create an appointment:

If you are in Day or Week view, tap the desired date and time for the appointment.
1. Tap New.

Tap to return to the calendar
(the appointment is saved
automatically).

il £ 7. Tap to choose from
i:j LElfETikT < 7:52 @ Jﬁ predefined text.
Subject: -
Location: +* —— Tap to choose from

previously entered locations.

Starks: 243/02 12:00 PM v
Ends: 2/3/02 1:00 PR ¥ +—— Tap to select a time.
Type: Morrresd Tap to select a date.

Occurs: ONce

Reminder: Remind me
15 minute(s)
Categories: MO Ccateqories...
Appointment | Mokes Notes is a good place
123|1|2|3 4|5|E|?|B|9|l]|- =|* for maps and directions.
Tabja|wle[r|t[y[u]i]o[p
caplafs[d[f[a[h[j[k[I:]"
shift| z (2 [c v |b|n|m].
ctifaii] = [\] |
Edit |E

-~

4

Enter a description and location.
Adjust date and time as needed.
Enter other desired information. Hide the input panel to view all available fields.

a b~ D

Tap the Notes tab to add notes or a drawing, or to create a recording, for more information see
“Notes: Capturing Thoughts and Ideas” later in this chapter.

6. Tap OK when finished.

@ Note If you select Remind me in an appointment, your device will remind you according to the
options set in 5} Settings, Personal tab, Sounds & Notifications.
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Using the Summary Screen

Tap an appointment to display the summary screen. To make changes, tap Edit.

.gcj Calendar {1 a:12

Lunch w/ Adam iy

12:00p-1:00p Sun, 2f3f2002 —— View appointment details.
Carner Cafe

Femember portfolio. —— Display notes.

Edit Tools E|4

Tap to change
appointment.

Creating Meeting Requests

Calendar can set up meetings with Outlook® or Pocket Outlook® users. The meeting request will be
created automatically and sent either when you synchronize Inbox or when you connect to your
e-mail server. Indicate how you want meeting requests sent by tapping Tools then Options. If you
send and receive e-mail messages through ActiveSync®, select ActiveSync.

To schedule a meeting:

DRAFT

1. Create an appointment.

2. Inthe appointment details, hide the input panel, then tap Attendees.

3. Select the meeting attendees from your Contacts list. Tap OK.

The meeting notice is created automatically and placed in the Outbox folder.

For more information on sending and receiving meeting requests, see Calendar Help and
Inbox Help on the device.
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Contacts: Tracking Friends and Colleagues

Contacts maintains an easily accessible list of friends and colleagues. The device’s infrared (IR)
port allows you to quickly share Contacts information with other device users. To access Contacts,
tap fwj then Contacts. Or, press the Contacts Program button on the front of the device.

Select the category of contacts
you want displayed in the list.

All Contacts ~ | —}— Tap and enter part of a name to
#ahl cde| ﬁ;lh| iik | Imr‘|||:|r:|q| rot |u%.fW| WYz quickly find it in the list.

Barr, Adam (206) 555-1212 w —— Tap to see additional phone
Bready, Richard rich@proseware.... e numbers and e-mail addresses.

— Tap to display or edit

Create Copy the contact details.

Delete Contact

Tap and hold to display
a pop-up menu of actions.

Send E-mail to Contact...
Beam Contack...

New Yiew Tools E|*

1
| Tap to create a new contact.

@ Note Tap Tools then Options to change the way information is displayed.

All phone numbers stored in Contacts can be accessed from the Phone Book to place a
call.

When transfering the contact to another device by using infrared (IR), tap and hold that
contact, then tap the Beam Contact from the displayed pop-up menu. For more
information, See “Transfering Items Using Infrated” in chapter 8.
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Creating a contact:

1. Tap New.
Tap to return to the contact
list (the contact is saved
automatically).
Marmne: ¥ |~
Job title: ]
Department: :
Zompany:
Work kel
Work, Fax:
Worl: addr: hd
E-rnail: | |
Mahile bel: =1—— Scroll to see more fields.
Details | Mokes Notes is a good place
123| 1|2 |3 |4|5 |E. |? |E|'El |l]|- =|* for maps and directions.
Tablg|wie[r[t[y|uli|o|p[[]]
caPla|s[d|flaln]i[k[1][;]"
shift[ z[x [c[v|b|nim|,[.[/]+
cti[aii] " [\ ] [1]t]<]=
Edit =3

Enter name and contact information. Scroll down to see all available fields.

3. Tap Categories to assign the contact to a category. In the list, Contacts can be displayed by
category.

4. Tap the Notes tab to add notes or a drawing, or to create a recording. For more information,
see “Notes: Capturing Thoughts and Ideas” later in this chapter.

5. Tap OK when finished.

Finding a contact

There are four ways to find a contact from the contact list:
» Enter a name in the box under the navigation bar. To view all contacts clear text from the box
or tap the button to the right of the box.

« Tap the category list (labeled All Contacts by default) and select the type of contact you want
displayed. To view unassigned contacts, select No Categories. Select All Contacts to view
the entire contacts list.

» To view contacts by their company names, tap View, then By Company. The number of
contacts working for that company will be displayed to the right of the company name.

* Tap , Find, enter the contact name, select Contacts for the type, then tap Go.
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Using the Summary Screen

Tap a contact to display the summary screen. To make changes, tap Edit.

L.fg Contacks

Adam Gabor
Progratmtmer

Fal

Inspired Technalogies

—1— View contact details.

(206) 555-1212 work el
111 First St, work addr

Summary | Mokes

Tap to view or add notes.

Edit Tools E|~
|

Tap to change contact information.

95

DRAFT



DRAFT
Chapter 5: Microsoft® Pocket Outlook®

Tasks: Keeping aTo Do List
| then Tasks. Or, press the Tasks

Tasks keeps track of what has to be done. To access, tap f*j
Program button on the front of the device.

Select the category of tasks
you want displayed in the list.

All Tasks ~ Priority -~ Select the sort order

[ 1! Send status report Iofc;.hetllst.h. h oriorit

- : ndicates high priority.
[[] Buy birthday gift
[] call™Maria

[ ] Proof new proposal

BN Crhedula massage — Tap to display or edit

Create Copy the task details.
Delete Task Tap and hold to display
a pop-up menu of actions.
Beam Task...
New Tools E|*

|
| Tap to create a new task.

@ Note Tap Tools then Options to change the way information is displayed.
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Creating a task:

DRAFT

1. Tap New.

Subject:

Priorityw:
Skakus;
Skarks:

Cue:

DICCUrsS:
Feminder:

_akeqories:

Tap to return to the task
list (the task is saved
automatically).

Mormal

Mot Completed
MHone

Mone

once

Mo cateqories,.

—— Tap to choose from
predefined subjects.

Task | Motes

Notes is a good place

123)1[2[3|4|s|6|7|8]|o|0]-

Te

for maps and drawings.

rab[awle|r[€]y[ulilo]p

caP[as[d[fla[n]i[k[1]:]"

Shift| z

x|c[v]b|n]m]

ctiaii|

[\

|
v

|
| +

Edit

{—l—}
|«

2. Enter a description.

3. Enter a start and due date or other information by tapping the field. Hide the input panel to see
all the available fields.

4. Tap Categories to assign the task a category. In the list, Tasks can be displayed by category.

5. Tap the Notes tab to add notes or a drawing, or to create a recording. For more information,
see “Notes: Capturing Thoughts and Ideas” later in this chapter.

6. Tap OK when finished.

@ Note To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Then, tap
here to add a new task and enter your task information.
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Using the Summary Screen
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Tap a task to display the summary screen. To make changes, tap Edit.

Send status report o

Starts: 2faf2002
Ciue: 2/af2002

— View task details.

+—— Tap to show and hide additional

Send to the whole team using the new
format.

summary information.

— View notes.

Edit Tools E|n-

Tap to change task.
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Notes: Capturing Thoughts and Ideas

Notes quickly captures thoughts, reminders, ideas and phone numbers. You can also create a
recording to include with the entry.

[E All Folders ~ Manme «—— Tap to change the sort
[_|Business1 B:54a  dzap | crderofthelst

l]ul:luuk Notes1
Persunall

Tr—ama manankbims e

Create Copy
Delete

Tap to open a note or
play a recording.

Tap and hold to display
Select all a pop-up menu of actions.

Send via E-mail...
Beam File...

Rename;/Move...

! Tap to record.

- [— g

New Tools (=] El*
1 T

Tap to show or hide the
Recording toolbar.

Tap to create a new item.
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Creating a note:

1. Tap New.

2. Create your note by writing, drawing, typing, and recording. For more information about using
the input panel, writing and drawing on the screen, and creating recordings, see “Entering Text
Using the Input Panel” in Chapter 2.

Tap to return to the note
list (the note is saved
automatically).

{53 |Notes 4% 8:50

Team meeting notes: -

Adarm will send current status to core
team.

Julie will get the revenue numbers,

Tanner is back from the conference
and reports that the product was a

hig hit!

123/1[2[3]|4]s|e|7[8]|o|0]-[=[«
Tabjg|wle|r|t|y|uli[o[p[[]]
caPla[s[d[f[glh[j[k[I1][;]"]

shift| z[x[c[v[b]n[m|,[.]/]

ctifad] " [\ | [4[t]e]>

ST [EiE U E @ & |E‘ Tap to show or hide

1
| . the input panel.
Tap to write on the screen.

Tap to add a recording
to the note.
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Inbox: Sending and Receiving E-mail Messages

Use Inbox to send and receive e-mail messages in either of these ways:
» Synchronize e-mail messages with Microsoft® Exchange or Microsoft® Outlook® on your
computer.

» Send and receive e-mail messages by connecting directly to an e-mail server through an
Internet service provider (ISP) or a network.

Synchronizing E-mail Messages

E-mail messages can be synchronized as part of the general synchronization process. You will
need to enable Inbox synchronization in ActiveSync®. For information on enabling Inbox
synchronization, see ActiveSync® Help on the computer.

During synchronization:

* Messages are copied from the mail folders of Exchange or Outlook on your computer to the
ActiveSync folder in Inbox on your device. By default, you will receive messages from the
past five days only, the first 100 lines of each message, and file attachments of less than 100
KB in size.

« E-mail messages in the Outbox folder on your device are transferred to Exchange or Outlook,
and then sent from those programs.

» E-mail messages in subfolders must be selected in ActiveSync® on your computer in order to
be transferred.

@ Note You can also synchronize e-mail messages with your computer from a remote location.
For more information, see Chapter 8.

Connecting Directly to an E-mail Server
The phone on your device can send and receive e-mail messages by connecting to an e-mail
server. For more information about setting up this remote connection, see Chapter 8.
Once connected to the e-mail server:
* New messages are downloaded to the device Inbox folder,
* Messages in the device Outbox folder are sent; and
« Deleted messages are removed from the device Inbox folder

Messages received directly from an e-mail server are linked to your e-mail server rather than your
computer. When a message is deleted from your device it will also be deleted from the e-mail
server the next time you connect.

When working online connected to your server, you can immediately read and respond to
messages - they are sent as soon as you tap Send, saving space on your device.

To work offline, download new message headers or partial messages, and disconnect from the
server. You can then mark which messages to completely download the next time you connect.
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Using the Message List

Received messages are displayed in the message list - the most recently received are listed first.

Select the service and folder
you want to display.

Inbox - Received Date ~ — Select the sort order
& Robert Brown £ 4GP 16K for messages.
RE: Tuday's Meeting — Tap to open a message.
lay Adams Mark as Unread
RE: Please 4 mMove To.. ! Tap and hold to display
Andrew Dixo a pop-up menu of actions.
Skatus Repoy
(=3 Bradley Beck
RE: Lunch
Stuart Muns{ Reply All
PacketPC Forward
(=3 Linda Mitchel

Reply

Reminder Delete |
(=3 Jeff Smith FTHSET =T

RE: ‘Waorking lake

adam Barr T1SPM 1K |

1

Con't forget

Inbioy: AckiveSync 11 Ikems.
MNew Tools Services Eg E|*

Tap to connect and to
send and receive e-mail.

Tap to connect to
the selected service.
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When you receive a message, tap it to open it. Unread messages are displayed in bold.

Tap to return to
From: Robert Brown the message list.

Subject: RE: Todaw's Meeking
Sent: 2i11)02 5:45:47 AM

Just a reminder to bring your individual
schedules for the next 2 quarters with

yioul, We will be discussing projects and
tirmelines,

Thanks,
Bob

Tap to delete this message.

New Edit = = & & E|“

|
Tap to view the previous
or next message.

Tap to reply to or
forward this message.

To retrieve a full message during your next synchronization or e-mail server connection, tap and
hold the message. On the pop-up menu tap Mark for Download.

Specify downloading preferences when you set up the service or select your synchronization
options.

* Inbox synchronization options can be changed using ActiveSync® options. See ActiveSync®
Help for more information.

» To change options for e-mail server connections, tap Tools then tap Options. On the Service

tab, tap the service you want to change. To remove a service, tap and hold the service and
select Delete.
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Composing Messages

1. Tap New.

2. Inthe To field, enter the e-mail addresses of the recipients, separating the names with a semi-
colon, or select a name from the contact list by tapping and holding To, or by tapping the
Address Book button.

Tap to send the message.

Subj: < ... > ¥1— Tap to show or hide
the complete header.

New Edit My Text [5] = E|*
1 1 1

Tap to show / hide the
recording toolbar.

Tap to display the Address Book.
Tap to insert common messages.

3. Compose your message. To enter preset or frequently used messages, tap My Text and select
a message.

4. Tap Send when you've finished the message. If you are working offline, the message is moved
to the Outbox folder and will be sent the next time you connect.
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Managing E-mail Messages and Folders

Messages are displayed in one of five folders: Inbox, Deleted Items, Drafts, Outbox and Sent
Items. The Deleted Items folder contains messages that have been deleted on the device. The
behavior of the Deleted and Sent Items folders depends on the options you have chosen. In the
message list, tap Tools then Options. On the Message tab, select your options.

To create new folders, tap Tools then Manage Folders. To move a message to another folder, tap
and hold the message and then tap Move to on the pop-up menu.

Folder behavior with a direct connection to an e-mail server

The behavior of the folders you create depends on whether you are using ActiveSync®, POP3, or
IMAPA4:

« If you use ActiveSync®, e-mail messages in the Inbox folder in Outlook® will automatically be
synchronized with your device. You can select to synchronize additional folders by
designating them for ActiveSync®. The folders you create and the messages you move will
then be mirrored on the server. For example, if you move two messages from the Inbox folder
to a folder named Family, and you have designated Family for synchronization, the server
creates a copy of the Family folder and copies the messages into that folder. You can then
read the messages while away from your computer.

* If you use POP3 and you move e-mail messages to a folder you created, the link is broken
between the messages on the device and their copies on the mail server. The next time you
connect, the mail server will see that the messages are missing from the device Inbox and
delete them from the server. While this eliminates duplicate copies of messages, you will no
longer have access to messages moved to folders created anywhere except the device.

* If you use IMAP4, the folders you create and the e-mail messages you move are mirrored on
the server. Therefore, messages are available to you anytime you connect to your mail
server, whether it is from your device or computer. This synchronization of folders occurs
whenever you connect to your mail server, create new folders, or rename/delete folders when
connected.
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Companion programs include Microsoft® Pocket Word, Microsoft® Pocket Excel, Windows Media™
Player for Pocket PC, and Microsoft® Reader.

, then Programs, then the program name.

To switch to a companion program, tap fwj

Pocket Word

Pocket Word works with Microsoft® Word on your computer, providing easy access to copies of
documents. You can also create new documents on your device or copy documents from your
computer.

To create a new file, tap fwj Programs, Pocket Word, then New. Or, from the Today screen, tap
New, then Word Document. Only one document can be opened at a time; when you open a
second you will have to save the first. Documents can be saved in a variety of formats including
Word (.doc), Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt).

Pocket Word contains a list of stored files. Tap a file to open it, and tap and hold to delete, make
copies of, or send it from the pop-up menu.

Select the type of folder you
want displayed in the list.

.faI Pocket Word

[E All Folders - Name «—— Tap to change the sort
Agenda 927 a 420b order of the list.
Doc1 9:22 a 416h
Meeting notes 9:22 a 428h
= l:-l-‘E-El.l:E.l:upy 9:23 a 424b +— Tap to open a document.
Delete
Select all Tap and hold an item to see

a pop-up menu of actions.

Send yia E-mail...
Beam File...

Rename,/Move...

MNew Tools E|*

Tap to create a new document.
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You can enter information in Pocket Word in one of four modes (typing, writing, drawing, and
recording), which are displayed on the View menu. Each mode has its own toolbar, which you can
show and hide by tapping the Show/Hide Toolbar button on the command bar.

é/? Note You can change the zoom magnification by tapping View then Zoom. Then select the

percentage you want. Select a higher percentage to enter text and a lower one to see
more of your document.

If you're opening a Word document created on a computer, select Wrap to Window on
the View menu so that you can see the entire document.

Typing Mode

Enter text using the input panel (See “Entering Text Using the Input Panel” in Chapter 2 for more
information). To format or edit text, highlight it by dragging the stylus over the text you wish to
select. Use the Edit menu or toolbars for formatting changes.

A document can be searched for text by tapping Edit then Find/Replace.

Tap to return to the
document list (changes are
saved automatically).

Tap and hold to see a
pop-up menu of actions.

efg Pockel ool

Cuk

Vieeting not Copy
Clear
Format...
Paragraph...
Tap to change
formatting options.
B T _5PIE“ EIhEEk = } Tap to format text.
12301]2]3[4[s5[6[7[8]9]0]- =]«
Tabla|wle[r|t[y[u|i[o[p[[]]
CaPlals[d[flg[h]ilk[I];]"]
shift] z[x [c[v[b][n]m],[. /]«
Cti|aii] - [\ ] [4]t]<]>
New Edit Yiew Tools | T, |E &
Tap to show or hide
the toolbar.
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Writing Mode

In writing mode, use your stylus to write directly on the screen. Ruled lines are displayed as a
guide, and the zoom magpnification is greater than in typing mode to allow you to write more easily.
For more information on writing and selecting writing, see “Entering Text Using the Input Panel” in
Chapter 2.

¥ |Pocket Word 4% 12:08 (9
] o’ N N

H. S ﬁ- P )‘f |—| With Space button selected,

Ll drag to insert space. An arrow
appears showing the space
direction and size.

W §|‘ |& | v ———Tap to highlight selected text.
N}aw Edit \ri}aw Tuu*s t, E|d-

Tap to select formatting options,
such as pen weight and line color.

Space button.

Pen button.

@ Note If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, and
can be edited and manipulated as described in the following section.

Written words are converted to graphics (metafiles) when a Pocket Word document is
converted to a Word document on your computer.
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Drawing Mode

In drawing mode, use your stylus to draw on the screen. Gridlines appear as a guide. When you lift
your stylus off the screen after the first stroke, you'll see a drawing box indicating the boundaries of
the drawing. Every subsequent stroke within or touching the drawing box becomes part of the
drawing. For more information on drawing and selecting drawings, see “Entering Text Using the

Input Panel” in Chapter 2.

Select Shape on the

2f pocket Word

pop-up menu to convert
objects to proper shapes.

OOO

% 1210

Resize an object by dragging

T

\_,L

OOO
Ropom set UP

the selection handles.

A

2SS LI+ &+ o %

N}aw EdiY ¥iew Tools | T,

E|‘

Tap an arrow to

Pen button.

Recording Mode

see your choices.

Tap to select formatting options,
such as line weight, fill color, and line color.

In recording mode, you can embed a recording into your document. Recordings are saved as .wav
files. For more information on recording, see “Entering Text Using the Input Panel” in Chapter 2.

For more information on using Pocket Word, tap
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Pocket Excel

Pocket Excel works with Microsoft® Excel on your computer, providing easy access to copies of
spreadsheets. You can also create new spreadsheets on your device or copy spreadsheets from
your computer.

To create a new file, tap fwj Programs, Pocket Excel, then New. Or, from the Today screen, tap
New, then Excel Workbook. Only one spreadsheet can be opened at a time; when you open a
second you will have to save the first. Spreadsheets can be saved in a variety of formats including
Excel (.xIs) and Pocket Excel (.pls).

Pocket Excel contains a list of stored files. Tap a file to open it, and tap and hold to delete, make
copies of, or send it from the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools such as formulas, functions, sorting and
filtering. To display toolbar, tap View then Toolbar.

.-‘ff' Pocket Excel < 12:19 @

— Cell contents appear here
as you enter them.

A3 =SUM{AL:AZ)
A | B [ € |

Format button.

A | (L0 [ |
Hot
T
h
-
]

[T

| |
Ll |

AutoSum button.

| [ 1
Rpady  Sheetl | Sum=$66.00

]
1
-

F E = = IE & s .00 (&, ——— Zoom button.
123)1[2[3[4[s][e[7[8][9]0]-[=]«
Tabjq|wle[r|t|y|ulifo[p[[]]
caP[a[s[d[fJa]h]i[k[1];]"

shift[z [2 [c[v[b][n[m[.[.[/]+

Ctladi| = |\ ] <[>

New Edit Yiew Format Tools [T, |E -

@ Note If your spreadsheet contains sensitive information, you can protect it with a password. To
do so, open the file, tap Edit, then Password. Every time you open that file, you will need
to enter the password.
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Tips for Working in Pocket Excel

» To view in full screen mode, tap View then Full Screen. Tap Restore to exit mode.
» Tap View to select items you want to show or hide.

» To freeze panes, select the cell(s) you want to freeze, tap View then Freeze Panes. Freeze
the top and leftmost panes in a spreadsheet to keep row and column labels visible as you
scroll through a sheet.

* To split panes to view different areas of a spreadsheet, tap View then Split. Drag the split bar
to the desired location. To remove, tap View then Remove Split.

* To hide a row or column, select it then tap Format, then Row or Column, then Hide. To show
a hidden row or column tap Tools, then Go To, then type a reference that is in the hidden row
or column. Then tap Format, then Row or Column, then Unhide.

For more information on using Pocket Excel, tap then Help.
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MSN® Messenger

MSN® Messenger on your mobile device is an instant messaging program that lets you:
 View a list of instant messaging contacts who are online.
» Send and receive instant messages.
» Have instant message conversations with groups of contacts.

To use MSN® Messenger, you must have a Microsoft Passport™ account or a Microsoft® Exchange
e-mail account. If you have a Hotmail® or MSN® account, you already have a Passport. Once you
have obtained either a Microsoft Passport™ or a Microsoft® Exchange account, you are ready to
set up your account.

@ Note Sign up for a Microsoft Passport™ account at http://www.passport.com. Get a free
Microsoft® Hotmail® e-mail address at http://www.hotmail.com.

To switch to MSN® Messenger, tap , Programs, then tap MSN Messenger.

Setting Up

Before you can connect, you must enter Passport or Exchange account information.

To set up an account and sign in:

1. Inthe Tools menu, tap Options.
2. On the Accounts tab, enter your Passport or Exchange account information.
3. To sign in, tap the sign-in screen and enter your e-mail address and password.

@ Note If you use MSN® Messenger on your computer, your contacts will automatically show up
on your device.
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Working with Contacts

The MSN® Messenger window displays all your message contacts divided into Online and Not
Online categories. While connected, tap and hold any contact and a pop-up menu appears
allowing you to chat, send e-mail, block the contact or delete the contact.

e{g MSN Messenger o< 5:09 @

;j. Kim Akers {Online)
;5,' Online

;ﬂ. Adarn Barr

;j. Ja

Efn. Fandall {aweay)
i Mot Online

..i Richard Bready
i David Hodgson

—— Tap a contact to start a chat.

Send Mail (Tim@woodgrovebank.c...
Block ——— Tap and hold to display
Delete Contact a pop-up menu of actions.
Properties

Tools E|‘

@ Note To see others online without being seen, in the Tools menu, tap My Status and select
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Appear Offline.

If you block a contact, you will appear offline but will remain on the blocked contact’s list.
To unblock a contact, tap and hold the contact, then tap Unblock on the pop-up menu.
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Chatting with Contacts

Tap a contact name to open a chat window. Enter your message in the text entry area at the
bottom of the screen, or tap My Text to enter a preset message, and tap Send. To invite another
contact to a multi-user chat, in the Tools menu, tap Invite and tap the contact you wish to invite.

l.fy|M5N Messenger o= 1:56 @

| Enter message.

R I
Hi. Can wou meet at 2:007 Sendi— Tap to send message.

1231[2[3]|4|5[6[7[8|9[0[- =]
Tabla|w]e|r [ t][y[u]i]o]p
CAPla[s|d[flah]i[k[1];]"

shift|Z |2 [c|¥ [b|n[m],|.] /]
culai] " [\] [t ]«]>
Tools Chats My Text ;3. |E -

@ Note To switch back to the main window without closing a chat, tap the Contacts button. To

revert back to your chat window, tap Chats and select the person whom you were
chatting with.
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To see if the contact you are chatting with is responding, look for the message under the text entry
area.

l.fij'|M5N Messenger o< 1:57 @

——— View full chat.
Hi. Can vou meet ak 2:007

Jﬁﬂdam is Typing a message. —— View status of the chat.
123(1]2[3[4[s[e[7[8]o]0]-[=]«
Tabjg|wle[r[t|y[ufi[o[p[[]]
caPlals[d[fg[h[ilk[I[;]"]
shift| z [x[c[¥[b|n[m]|.[.]|/]+
ctjad] [\ ] [4]t]<]>
Tools Chats My Text .,j. |E -

For more information on using MSN® Messenger, tap {1} then Help.
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Windows Media™ Player for Pocket PC

Use Microsoft® Windows Media™ Player for Pocket PC to play digital audio and video files that are
stored on your device or on a network. To switch to Windows Media™ Player for Pocket PC, tap

Jiat], then tap Windows Media.

[0 1 B x
1 1 1] [} 1
ae
pdla F -
Indicates the progress
Read Press Pla )00 of the current track.
Tap to adjust volume
Select Tools E|*
Tap Tap to skip to
to the next file.
Stop. | Tap to play
Tap to play a previous file.
or pause.

Use Microsoft® Windows Media™ Player on your computer to copy digital audio and video files to
your device. You can play Windows Media™ and MP3 files on your device.

Windows Media™ player can be used even if the screen is turned off. Tap Tools, Settings then
Buttons, and select the Scan Toggle from the pull-down list beside “Select Function”, then press
the hardware button you wish to allocate. By pressing the allocated button, you can turn on and off
the screen.

For more information about using Windows Media™ Player for Pocket PC, tap , then tap Help.
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Microsoft® Reader

Microsoft® Reader enables you to read eBooks on your device. Using ActiveSync®, book files can
be copied from your computer to your device.
Each book consists of a cover page, an optional table of contents, and the pages of the book. You
can:

» Page through the book by using the Up/Down control on your device or by tapping the page

number on each page.

» Annotate the book with highlighting, bookmarks, notes, and drawings.

» Search for text and look up definitions for words.
The Guidebook contains detailed information on using the software. To open, tap Help on the
Reader command bar. From a book page, tap and hold the book title, then tap Help on the pop-up
menu.

To open Microsoft® Reader, tap , Programs then Microsoft Reader.

Getting Books on Your Device

Download book files from the Web by visiting your favorite eBook retailer and following the
directions for downloading.

The Thera Companion CD also includes sample books and a dictionary in the MSReader folder of
the Extras folder.

The Read Me file in the MSReader folder gives directions for using ActiveSync® to download files
from your computer.
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Using the Library
The Library is your Reader home page,; it displays a list of all books stored on your device or
storage card.
To open the Library:
* On the Reader command bar, tap Library.
» On a book page, tap the book title, and then tap Library on the pop-up menu.
To open a book, tap its title in the Library list.

l.:"{-—.?" Microsoft Reader £ 6:56 9

_Page1 Tap to scroll through
the Library list.

Library
Tap to select

asort order. Winter of the Walf Moon

Wednesday, November 14, 2001

—— Tap to open a book.
The Ghost Writer
Tap to specify Wednesday, November 14, 2001
the books you

want to display

The Hundred Secret Senses

in the list. Monday, October 20, 2001
Cutlander
Monday, October 2z, 20071
——
Tap here to Suger Plum Dead
navigate to Monday, October 22, 2001
other parts
of the Reader. Ancther Waorld

Return
Monday, October 22, 2001

Reader command bar.
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Reading a Book
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Each book consists of a cover page, an optional table of contents, and the pages of the book.
Navigation options are listed in the bottom portion of the cover page.

The first time you open a book, you'll probably want to go to the first page or to the table of
contents, if there is one. Subsequently, whenever you open the book, you'll be automatically taken
to the last page read.

In addition to the text, each book page includes a page number and book title.

—

Tap to select
a navigation
option.

|~ The Call of the Wild

were booming the find, thousands

of men

rushing into the

Morthland., Th
dogs, and the
were heavy d
muscles by whid
coats to prote
frost.

Buck lived

Add Bookmark
Add Highlight
Add Note

Add Drawing

Find. ..
Copy Text

which glimpses

4

the sun-kissed Sama Crarg vaney.
Judge Miller's place, it was called.
It stood back from the road, half
hidden among the trees, through

could be caught

of the wide cool veranda that ran

T

I
Drag to select text and
then tap an option.

Tap arrows to turn
the page, or tap and
hold page # to bring
up page riffle.

You can also page through a book by using the Up/Down control on your device.
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Using Reader Features

Reading an eBook gives you several options not available with paper books. Select text by
dragging stylus across it and follow options outlined below:
» Search for Text: Find text by tapping Find on the pop-up menu. Enter your search word and
tap the desired Find option. Results are highlighted on the page. Tap outside the box to close
Find, and to return to your original page, tap the title then Return on the pop-up menu.

e Copy Text: You can copy text from books into any program that accepts text. Select the text
you want to copy, then tap Copy Text on the pop-up menu. Paste it into the program of your
choice.

* Bookmarks: When Bookmark is selected from the pop-up menu, a color-coded bookmark
appears in the right margin. Multiple bookmarks can be added, and they can be accessed
from anywhere in the book by tapping the bookmark icon.

« Highlights: When text is highlighted it appears with a colored background.

« Notes: Enter text in the note that appears on top of the page. To show or hide the note, tap
the Note icon displayed in the left margin.

e Drawing: When you add a drawing, a Drawing icon appears in the top-right corner of the
page along with tools on the bottom of the page.

« Tap Go to then Annotations on the book’s cover page to see a list of the book’s annotations
including bookmarks, highlights, text notes and drawings. Tapping an entry takes you to the
annotated page.

Removing a Book

When you finish reading a book, it can be deleted (to conserve space) by tapping and holding the
title in the Library list, and then Delete on the pop-up menu.
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Use Microsoft® Pocket Internet Explorer to view Web or WAP pages in either of these ways:

 During synchronization with your computer, download your favorite links and mobile favorites
that are stored in the Mobile Favorites subfolder in Internet Explorer on the computer.

» Connect to an Internet service provider (ISP) or network and browse the Web. See
“Accessing the Internet” in Chapter 3.

When connected to an ISP or network, you can also download files and programs from the Internet
or intranet.

To switch to Pocket Internet Explorer, tap

f-rj then Internet Explorer.

The Mobile Favorites Folder

Only items in your computer’s Mobile Favorites folder will be synchronized with your device. This
folder is automatically created when ActiveSync® is installed.

Favorite Links

During synchronization your computer’s Mobile Favorites folder is synchronized with your device’s
Pocket Internet Explorer. Both computers are updates each time you synchronize. If the link is not
marked as mobile favorite, you will have to connect to your ISP or network to view page content.
For more information, see ActiveSync® Help on the computer.

Mobile Favorites

If you are using Microsoft® Internet Explorer 5.0 or later on your computer, you can download
mobile favorites to your device. Synchronize the web content of your mobile favorites downloads to
your device so that you can view pages while you are disconnected from your ISP and computer.

Use the Internet Explorer plug-in installed with ActiveSync® to create mobile favorites quickly.

To create a mobile favorite:

1. In Internet Explorer on your computer, click Tools then Create Mobile Favorite.

2. To change the link name, enter a new name in the Name box.

3. Optionally, in Update, select a desired update schedule.

4. Click OK. Internet Explorer downloads the latest version of the page to your computer.
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5. If you want to download the pages that are linked to the mobile favorites you just created, right-
click the mobile favorite then click Properties. In the Download tab, specify the number of links
deep you want to download. To conserve device memory, go only one level deep.

6. Synchronize your device and computer and the Mobile Favorites folder will be downloaded to
your device.

@ Note If an update scheduled was not specified in step 3, content will have to be manually
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downloaded to keep both computers updated. To see the last time content was
downloaded to the computer, click Tools then Synchronize from the Internet Explorer
window. Manually download content as needed.

To add a button to your computer’s Internet Explorer toolbar for creating mobile favorites,
click View, Toolbars then Customize.

Saving device memory
To minimize the amount of memory used by mobile favorites:

* In the Favorites settings, select ActiveSync® options and turn off pictures and sounds, or stop
select mobile favorites from being downloaded. For more information see ActiveSync® Help.

« Limit the number of downloaded linked pages. On your computer’s Internet Explorer, right
click the mobile favorite you want changed and then Properties. In the Download tab,
specify 0 or 1 for the number of linked pages you want to download.
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Using AvantGo Channels

AvantGo, a free interactive service that provides access to personalized content and popular
websites, can be subscribed to directly from your device. Content can be downloaded when you
synchronize your device and computer, or directly from the Internet. Visit the AvantGo website for
more information.

To sign up for AvantGo:

1. In ActiveSync® options on the computer, turn on synchronization for the AvantGo information
type.

2. In Pocket Internet Explorer on your device, tap the Favorites button to display your list of
favorites.

3. Tap the AvantGo Channels link.
4. Tap the Activate button.

5. Follow the directions on the screen. You will need to synchronize your device with your
computer and then tap the My Channels button to complete the AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your list of favorites to see a
few of the most popular channels. To add or remove channels, tap the Add or Remove link.
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Using Pocket Internet Explorer

Without connecting to the Internet, Pocket Internet Explorer can browse mobile favorites and

channels that have been downloaded to your device. Or, you can connect to the Internet through
an ISP or a network connection.

'_:r-—j Internet Explorer < 5115 9

Tap below For useful sites and sarvicas!

'. PocketPC.com

ﬁ AUDIOVOX.

COMMUNICATIONS CORP

msn*" Mobile
@A AvantGo®

view Tools & ¥ &} 1 % E|"‘“

‘Hide pictures button.
Favorites button.

Home button.
Refresh button.
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To view mobile favorites and channels:

DRAFT

1. Tap the Favorites button to display your list of favorites.

l.ﬂ;“ Internet Explorer o< 8:50 @

Favorites

53 Mobile Favarites

----- ﬁ; AvantGo Channels

[ Packet PC web Guide

i Pocket PC.oom

----- {7 WindowsMedia.com

———— Tap the favorite you

Open | &dd | Delete

E|“‘

2. Tap the page you want to view.

want to view.

Tap to add or delete
a folder or favorite link.

The version of the page that was downloaded the last time you synchronized will be displayed. If
the page is not on your device, the favorite will be dimmed. Synchronize with your computer to
download the page to your device, or connect to the Internet to view the page.

To browse the Internet:

1. Set up a connection to your ISP or corporate network using Connections, as described in

Chapter 8.

2. To connect and start browsing, do one of the following:

» Tap the Favorites button, and then tap the favorite you want to view.

« Tap View then Address Bar. Enter the destination web address and tap ¢ . Tap the arrow to
select from previously entered websites.

@ Note To add a favorite link, tap and hold on the page and tap Add to Favorites in the pop-up

menu.
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Your device can exchange information with other mobile devices as well as your computer, a
network, or the Internet. The connection options include the following:

» The device’s infrared (IR) port can send and receive files from another device. See
“Transfering Items Using Infrared” below for more information.

* When connected to the Internet via your service provider, you can send and receive e-mail by
using Inbox and view web and WAP pages using Pocket Internet Explorer. Your service
provider should provide the software necessary to install other services, such as paging and
faxing. See “Connecting to the Internet” later in this chapter for more information.

* When connected to a Network you can send and receive e-mail by using Inbox and view web
and WAP pages using Pocket Internet Explorer and synchronize with your computer. See
“Connecting to the Work” later in this chapter for more information.

» Remotely connect to your computer to synchronize information such as Pocket Outlook®. See
ActiveSync® Help on your computer or Connection Help on your device for more information.

Transfering Items Using Infrared

Using infrared (IR), you can send and receive information, such as contacts and appointments,
between two devices.

To send information:

1. Locate the item to send.
2. Align the IR ports so that they are unobstructed and within a close range.
3. Tap and hold the item, and tap Beam Item on the pop-up menu.

@ Note You can also send items, but not folders, from File Explorer. Tap and hold the item you
want to send, then tap Beam File on the pop-up menu.

To receive information:

1. Align the IR ports so that they are unobstructed and within a close range.

2. Have the owner of the other device send the information to you. Your device will automatically
receive it.
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Connecting to the Internet

You can connect to your ISP, and use the connection to send and receive e-mail messages and
view Web or WAP pages.

@ Note To use Watcher to connect to the Internet, see “Accessing the Internet” in Chapter 3.
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Creating a modem connection to an ISP:

1.

R

Obtain the following information from your ISP: ISP dial-up access telephone number, user
name, password, and TCP/IP settings. Some ISPs require information in front of the user
name, such as MSN/username.

Tap then Settings. In the Connections tab, tap Connections. Under The Internet
settings, select Internet Settings and tap Modify.

In the Modem tab, tap New.
Enter a name for the connection, such as “ISP Connection.”
In the Select a modem list, select Sierra Wireless SB555 Modem.

You should not need to change any settings in Advanced. Most ISPs now use a dynamically-
assigned address. If the ISP you are connecting to does not use a dynamically-assigned
address, tap Advanced then the TCP/IP tab, and enter the address. When finished, tap OK
and then Next.

Enter the access phone number, and tap Next.

8. Select other desired options, and tap Finish.

In the Dialing Locations tab, specify your current location and phone type. These settings will
apply to all connections you create.

To automatically start a connection perform one of the following tasks:

» Use the Inbox to send and receive messages. Review “Connecting Directly to an E-mail
Server” later in this chapter for detailed set-up instructions.

» Use Internet Explorer to visit Web and WAP pages. See Chapter 7 for more information.

» Use MSN® Messenger to send and receive instant messages. See “MSN® Messenger” in
Chapter 6 for more information.
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Connecting to Work

To connect to a network at work, you need to set up a RAS account through your network
administrator, then follow the steps below in “To create a modem connection to a network.”

» Create a modem connection by using a RAS account. Before you can create this modem
connection, your network administrator will need to set up a RAS account for you. If this is the
method you want to use, see “To create a modem connection to a network.” Your network
administrator may also give you VPN settings.

To create a modem connection to a network:

1.

o g bk w

Get the following information from your network administrator: dial-up access telephone
number, user name, password, domain name, and TCP/IP settings.

Tap fwj then Settings. In the Connections tab, tap Connections. Under The Internet
settings, select Work Settings and tap Modify.

In the Modem tab, tap New.
Enter a name for the connection, such as “Company Connection.”
In the Select a modem list, select Sierra Wireless SB555 Modem.

You should not need to change any settings in Advanced. Most servers now use a
dynamically-assigned address. If the server you are connecting to does not use a dynamically-
assigned address, tap Advanced and then the TCP/IP tab and enter the address. When
finished, tap OK then Next.

Enter the access phone number, and tap Next.
Select other desired options, and tap Finish.

In the Dialing Locations tab, specify your current location and phone type. These settings will
apply to all connections you create.

To automatically start a connection perform one of the following tasks:

» Use the Inbox to send and receive messages. Review “Connecting Directly to an E-malil
Server” later in this chapter for detailed set-up instructions.

» Use Internet Explorer to visit Web and WAP pages. See Chapter 7 for more information.

» Use MSN® Messenger to send and receive instant messages. See “MSN® Messenger” in
Chapter 6 for more information.

» Synchronize. See ActiveSync® Help on the computer for more information.
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Ending a Connection

To disconnect, do one of the following:
« When connected via dial-up or VPN, tap the Connection icon, +}], on your navigation bar and
tap End.
* When connected via cable or cradle, detach your device from the cradle.
* When connected via Infrared, move the device away from the other one.

Connecting Directly to an E-mail Server

You can set up a connection to an e-mail server so that you can send and receive e-mail
messages by using a modem or network connection and Inbox on your device.

@ Note The ISP or network must use a POP3 or IMAP4 e-mail server and an SMTP gateway.

You can use multiple e-mail services to receive messages. For each e-mail address you intend to
use, set up and name the e-mail service following the directions below.

To set up an e-mail service:

* In Inbox on your device, tap Services, then New Service. Follow the directions in the New
Service wizard.

For an explanation of a screen, tap then Help. When finished, to connect to your e-mail server,
tap Services then Connect. For more information on using the Inbox program, see “Inbox:
Sending and Receiving E-mail Messages” in Chapter 5.

Get Help on Connecting

Additional help and information can be found in the following locations:

* “Inbox: Sending and Receiving E-mail Messages” in Chapter 5.

* Online Help on the device. Tap fwj then Help. Tap View, All Installed Help, then Inbox or
Connections.

* ActiveSync® Help on the computer. In ActiveSync®, click Microsoft ActiveSync Help on the
Help menu.

* For troubleshooting information, see the Pocket PC Web site at: http://www.microsoft.com/
mobile/pocketpc.
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Home

To easily launch the built-in or installed applications tap the icon displayed on the Home screen.

Launching an Application from Home

I35 Programs, then Home to display the Home screen.

1. Tap fuy,
You can also launch the Home by pressing the device Home Program button.

For initial setting, the respective application
icons are registered on three tabs: Main,
Programs and Games. In the Running tab,
active applications are displayed.

r=t
I

7

;
J
¥

1L

Home

Tap to select Tab Settings or About.

Edit ¥iew Tools E{A-

Tap to select Large Icon, Small Icon or Text color.

Tap to select Paste or Add.

2. Tap the desired tab, then tap the application icon you want to launch.

@ Note Press the Home Program button to switch tabs.
An application can also be launched by moving the cursor button to select a program and
pressing it to launch.
You can add up to 10 tabs, with up to 18 icons in each.
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About Running

The Running tab displays active applications. Icons do not appear.

To activate/stop the application:

To activate an application tap its name, or tap Activate in the pop-up menu.

Activate Tap to activate the selected application.

Internet Explore

Stop Tap to stop the selected application,
Stop All when finished, the application name disappears.

Tap to stop all applications displayed
in the Running tab.

Tap View to select Text Color. Tap Tools for
Tab Settings or About.

Yiew Tools E|*

@ Note Tap and hold anywhere on the Running tab, except the application names, and Stop All
appears in the pop-up menu.
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Display Icon List

136

The following list shows the tabs and icons for the initial setup.

Tabs Icons Applications Tabs Icons Applications

Running Programs @ Front Light

Main ? Watcher w Power
e Pocket Internet Explorer ?} File Explorer
@ Windows Media™ Player @? Backup
D Notes 2| | Infrared Receive
ra. Tasks “f-" Microsoft® Reader
@ Inbox i MSN® Messenger
Calendar Games @ Solitaire
Contacts
W] | Pocket Word
X

Pocket Excel

|

Calculator
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Moving an Application Icon into Another Tab

A moved icon appears next to the last icon in its new location. It cannot be moved to a tab that
already contains 18 icons.

To move using pop-up menu:

1. Tap and hold the icon to be moved.
2. Tap Cut on the pop-up menu.
3. Tap the destination tab, then tap Paste on the Edit menu.

@ Note You can also select Paste from the pop-up menu displayed by tapping and holding any
portion other than the icon.

To move using drag and drop:

Tap the icon you want to move and drag it to the destination tab, after the tab name is highlighted,
drop it.
The icon is transferred and deleted from its original location.

Deleting an Icon

1. Tap and hold the icon to be deleted.
2. Tap Drop on the pop-up menu.

@ Note You cannot delete the Watcher icon.
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Adding an Icon

Application and file icons can be added to the Home screen.
1. Tap Edit, then Add to display the Add Application screen.

You can also select Add from the pop-up menu displayed by tapping and holding any portion
other than the icon.

2. Tap v of Application file to show the file list. If there is no desired file on the file list, you can
find it by tapping Browse. To refer to all folders and files, tap Browse to show the Browse
Dialog screen. When the file is selected, its name is displayed in the Application file box.

Tap to designate a folder you want to browse.
When a storage card is inserted,

files or folders contained in the storage

card are displayed from the

top directory.
Folder: |l —— Tap to move up one level in the directory folders.
Type :|E}:ecutahle files(™*.exe) v|
— Tap to select kinds of
Mame Date *| | application or file to be browsed.
™ addrbook . exe 7i27j01 1,575
Bf backup.exe 10/24/01 6:1
calc.exe 6f20/01 11:4
™ calendar.exe 727001 1.57 L I a file is selected from the list, the screen
E calhot. exe 7i27/01 1:57 returns to the Add Application screen.
™ clack.exe 6/20/01 11:4
™ clocknot.exe 62001 11:4[+]
4| [ | [+ -
]

3. Enter an icon name (up to 32 characters) in the Application name box that will display on the
Home screen.

4. Tap OK when finished.

@ Note A new icon cannot be added if the Application file is not designated or if the Application is
not entered.

An icon added from a storage card cannot be launched unless the same card is inserted
in the device.
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Tab Setting

Atab can be added, deleted, or removed from the Tab Settings screen.

To add a tab:

1.

Tap Tools, then Tab Settings.

2. Tap New to display a text box.
3.
4. Tap OK on the Tab Settings screen to return to the Home screen.

Enter the new tab name (up to 10 characters) and tap OK when finished.

To delete a tab:

1.
2.

Tap Tools, then Tab Settings.

Select the tab to delete, then tap Delete. Tap Yes or No in the confirmation box. All icons
contained in the tab will also be deleted.

Tap OK on the Tab Settings screen to return to the Home screen.

@ Note You cannot delete the Running tab or the tab containing the Watcher icon.

To change the name of a tab:

1. Tap Tools, then Tab Settings.

P wDN

Select the tab to be renamed and tap Rename.
Enter a new name (up to 10 characters), and tap OK when finished.
Tap OK on the Tab Settings screen to return to the Home screen.

@ Note You cannot rename the Running tab.

To change a background:

1.

Select the background setup tab on the Tab Settings menu, then tap Browse to display the
Browse Dialog screen.

Even if a storage card is inserted, the files in the storage card will not be displayed.

2. Tap the desired bitmap file from the list to return to the Tab Settings screen.

3. Tap OK on the Tab Settings screen to return to the Home screen.

@ Note Only bitmap files can be set on the screen background. The displayable range of the

bitmap image on the Home screen is 240 (W) X 246 (H).
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Text Color Setting

To set the Text Color:
1. Tap the tab whose color you want to set to display the selected tab screen.
2. Tap View, then Text Color to display the color list.
You can set the color of the application name as desired.
3. Tap the color you want to set, and the color of the application name changes.

140



i i DRAFT
Chapter 9: Optional Functions

Backing Up
Device data can be backed up in a storage card, which can be later restored to your device.
Periodical data backup is strongly recommended.

The following types of data can be backed up:
« File: Files created by Pocket Word, Pocket Excel, Notes or other installed programs. Other
files stored in the memory.
* Registry: Setting information on Windows® CE or Built-in Program.
» Database: Microsoft® Pocket Outlook® database information.
Password data and other menu setup information cannot be restored.

Before backing up, restoring, or deleting a backup file, connect an AC Adapter to your device, set
the Radio Standby Switch to OFF and close all applications.

@ Note If you update ROM programs using special installation programs with a *.xip extension,
do not use the backup data made before updating the ROM programs.

When the system was changed, data that was backed up before the change cannot be
restored.

Making a Backup

1. Insert a storage card.
2. Tap fwj Programs, then Backup to display the Backup screen.
3. Select Backup from Functionality.

.'%-?'1 Backup s 12:21 e

Functionality
() Backup
{ ) Restore
() Delete Backup File

Storage Card: 61968KE  available
Main Mernory aEEkE N use
Last backup :

0K Cancel

Tools E|-‘~
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4. Tap OK to display the screen confirming all the applications are closed.
5. Tap OK to display the Backup password input screen.
6. Enter a password.

Password

Enter a password.

You can enter a password up to 16 characters.
Please do not tap the screen except Backup can be made even without entry of a
cancel while backing up. password. If a password is entered, that

password is required at the time of restore.

Are woul sure to start?
0K Cancel

123}1[2[3]4[5]e[7[8]o]0]-[=]
Tabja|wle[r[t[y|ulio[p
caPlafs[d[f[a[n[ji[k[1]:]"
shiftfz[x[c[v[b[n[m].
ctfaia] " [\ ] |

—

&

@ Note If you choose a password, do not forget it. Backup data cannot be restored without

entering it.

7. Tap OK. The progress bar is displayed during the backup process.
When the backup is completed, the backup finish message appears.
8. Tap OK to return to the previous screen.

é/? Note The backup process stops if the remaining storage card capacity runs low. Check the
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storage capacity before starting to back up.

If the storage card is write protected it cannot save backup data. Cancel the write
protection before backing up.
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Carrying Out Restore Operation

To restore is to overwrite the backed up data from the storage card onto the main memory of your
device.
« If the same file name exists in the main memory of your device, this file data is replaced with
the backup data from the storage card.

« If files exist in the main memory but not in the backup file, they will not be overwritten.
1. Insert the storage card, which contains backup data into your device.
2. Tap fwj Programs, then Backup to display the Backup screen.

3. Select Restore from Functionality.

Lﬂ;.j’j" Backup = 12:21 9

Functionality
{ ) Backup
(#) Restore
{ ) Delete Backup File

Storage Card: 61968KE  available
Main Mernory S6BKE  in use
Last backup : 02/01/02 12:20 AM

0K Cancel

Tools E|*

4. Tap OK to display the screen confirming all the applications are closed.
5. Tap OK to display the Restore password input screen.

6. Enter the password that was established for the backed up data. If you backed up without a
password, you do not need to enter one.

7. Tap OK. The progress bar is displayed during the restore process.
When the restore is completed, the restore finish message appears.
8. Tap OK. Your device is reset and restarts automatically.

@ Note If your device memory becomes short of its capacity during restore, the restore process
stops. Increase the memory allocation of the main memory of your device (see Chapter 2.
“Customize Your Device”), then restart the restore procedure.
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Deleting a Backup File
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1. Insert the storage card, which contains backup data to be deleted.
2. Tap [
3. Select Delete Backup File from Functionality.

, Programs, then Backup to display the Backup screen.

Functionality
{ ) Backup
{ ) Restare
(®) Delete Backup File

Storage Card: 61968KE  available
Main Mermory; S68KE  in use
Last backup . 02/01f02 12:20 &M

0K Cancel

Tools E|*

4. Tap OK to display the Delete Backup File confirmation screen.
5. Tap OK to delete the backup file.

DRAFT



DRAFT

Chapter 10
Additional Information



iti i DRAFT
Chapter 10: Additional Information

Resetting
Reset is equal to “Restart” on a computer. Reset only in unusual circumstances such as when the
screen freezes and doesn’t respond to tapping. Information not saved prior to resetting will be
deleted.
When your device is reset, phone functions are abruptly ended.
To reset, press and release the Reset Switch while the power is on. Once reset, the Today screen
appears.

@ Note If the function cannot be restored even after resetting, initialize your device (see “Clearing
Memory” on the next page).

* When the power is on, press the Reset Switch with the stylus, then release. By doing so,
reset is made and the Today screen appears.

[
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Clearing Memory (Initialization)

Initializing the device returns it to the status when it was originally purchased.

@ Note Initializing the device deletes all stored data, except built-in programs.
Before initialization, remove a storage card.

To initialize:
1. Turn off the power.

2. Press the Power button while pressing and holding the Reset Switch with the stylus, then
release the Power button.

3. Release the Reset Switch when a screen appears.

When initialization is complete, the welcome screen appears. Proceed with setup.
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External dimensions

3in. x 5in. x 3/4 in. (excluding protrusion part)
(77.5(W) x 127.5(H) x 19.5(D) mm)

Operating conditions

Temperature: 32°F to 104°F (0°C to 40°C), Humidity: 30 to
80% RH

» Temperature capable of charging: 41°F to 95°F (5°C to 35°C)
(According to the operating status, the charging may pause
even when the ambient temperature is below 95°F (35°C).)

Built-in battery
Type
Standby time
Continuing operating time

Memory keeping time

Advanced Lithium lon battery
Approx. ? hours. (Radio Standby Switch: ON, Power: OFF)

Approx. ? hours.
For continuous indication of the Today screen, front light: OFF,
ambient temperature: 77°F (25°C)

Approx. ? hours
If left at ambient temperature of 77°F (25°C) after the power is
not able to turn on.

Note: Continuing operating time and memory keeping time
vary according to the charging condition, ambient
temperature, operating condition, etc.

Infrared port
Stereo headphone jack

Cradle connection port
AC Adapter jack

Processor StrongARM SA-1110
Action clock 206MHz
Memory 32MB SDRAM
Display Reflective color TFT, 240x320 pixels, 65,536 colors
Interface
SD card slot Possible to insert SD memory card or SDI/O card

Note: The security function of the SD memory card is not
usable. Data encrypted by the SD memory card
security function-compatible equipment is not usable.

Based on IrDA Ver.1.2,
Maximum data transmission speed: 115 kbps

22.5mm, five poles stereo mini plug

AC Adapter

INPUT:  100-240V AC, 0.36-0.2A, 50-60Hz
OUTPUT: 5V DC, 3A
» An attached Power Supply Cable is a 125 V AC type.

DRAFT

Although the display is manufactured using an extremely high order of technology, there may be a
case that some dots do not light or always light. It is not a malfunction.
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FDA Consumer Update
I@ﬁ\ U.S. Food and Drug Administration -
r — Center for devices and Radiological Health Consumer Update on Mobile
Phones

1. Do wireless phones pose a health hazard?

The available scientific evidence does not show that any health problems are associated with
using wireless phones. There is no proof, however, that wireless phones are absolutely safe.
Wireless phones emit low levels of radiofrequency energy (RF) in the microwave range while being
used. They also emit very low levels of RF when in the stand-by mode. Whereas high levels of RF
can produce health effects (by heating tissue), exposure to low level RF that does not produce
heating effects causes no known adverse health effects. Many studies of low level RF exposures
have not found any biological effects. Some studies have suggested that some biological effects
may occur, but such findings have not been confirmed by additional research. In some cases,
other researchers have had difficulty in reproducing those studies, or in determining the reasons
for inconsistent results.

2. What is FDA's role concerning the safety of wireless phones?

Under the law, FDA does not review the safety of radiation-emitting consumer products such as
wireless phones before they can be sold, as it does with new drugs or medical devices. However,
the agency has authority to take action if wireless phones are shown to emit radiofrequency energy
(RF) at a level that is hazardous to the user. In such a case, FDA could require the manufacturers
of wireless phones to notify users of the health hazard and to repair, replace or recall the phones
so that the hazard no longer exists.

Although the existing scientific data do not justify FDA regulatory actions, FDA has urged the
wireless phone industry to take a number of steps, including the following:

» Support needed research into possible biological effects of RF of the type emitted by wireless
phones;

» Design wireless phones in a way that minimizes any RF exposure to the user that is not
necessary for device function; and

» Cooperate in providing users of wireless phones with the best possible information on possible
effects of wireless phone use on human health.

FDA belongs to an interagency working group of the federal agencies that have responsibility for
different aspects of RF safety to ensure coordinated efforts at the federal level. The following
agencies belong to this working group:

» National Institute for Occupational Safety and Health

« Environmental Protection Agency

» Federal Communications Commission

» Occupational Safety and Health Administration

» National Telecommunications and Information Administration
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The National Institutes of Health participates in some interagency working group activities, as well.

FDA shares regulatory responsibilities for wireless phones with the Federal Communications
Commission (FCC). All phones that are sold in the United States must comply with FCC safety
guidelines that limit RF exposure. FCC relies on FDA and other health agencies for safety
guestions about wireless phones.

FCC also regulates the base stations that the wireless phone networks rely upon. While these
base stations operate at higher power than do the wireless phones themselves, the RF exposures
that people get from these base stations are typically thousands of times lower than those they can
get from wireless phones. Base stations are thus not the subject of the safety questions discussed
in this document.

3. What kinds of phones are the subject of this update?

The term “wireless phone” refers here to hand-held wireless phones with built-in antennas, often
called “cell,” “mobile,” or “PCS” phones. These types of wireless phones can expose the user to
measurable radiofrequency energy (RF) because of the short distance between the phone and the
user’s head. These RF exposures are limited by Federal Communications Commission safety
guidelines that were developed with the advice of FDA and other federal health and safety
agencies. When the phone is located at greater distances from the user, the exposure to RF is
drastically lower because a person’s RF exposure decreases rapidly with increasing distance from
the source. The so-called “cordless phones,” which have a base unit connected to the telephone
wiring in a house, typically operate at far lower power levels, and thus produce RF exposures far
below the FCC safety limits.

4. What are the results of the research done already?

The research done thus far has produced conflicting results, and many studies have suffered from
flaws in their research methods. Animal experiments investigating the effects of radiofrequency
energy (RF) exposures characteristic of wireless phones have yielded conflicting results that often
cannot be repeated in other laboratories. A few animal studies, however, have suggested that low
levels of RF could accelerate the development of cancer in laboratory animals. However, many of
the studies that showed increased tumor development used animals that had been genetically
engineered or treated with cancer-causing chemicals so as to be pre-disposed to develop cancer
in the absence of RF exposure. Other studies exposed the animals to RF for up to 22 hours per
day. These conditions are not similar to the conditions under which people use wireless phones, so
we don’t know with certainty what the results of such studies mean for human health.

Three large epidemiology studies have been published since December 2000. Between them, the
studies investigated any possible association between the use of wireless phones and primary
brain cancer, glioma, meningioma, or acoustic neuroma, tumors of the brain or salivary gland,
leukemia, or other cancers. None of the studies demonstrated the existence of any harmful health
effects from wireless phone RF exposures. However, none of the studies can answer questions
about long-term exposures, since the average period of phone use in these studies was around
three years.
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5. What research is needed to decide whether RF exposure from wireless phones poses a
health risk?

A combination of laboratory studies and epidemiological studies of people actually using wireless
phones would provide some of the data that are needed. Lifetime animal exposure studies could
be completed in a few years. However, very large numbers of animals would be needed to provide
reliable proof of a cancer promoting effect if one exists. Epidemiological studies can provide data
that is directly applicable to human populations, but 10 or more years’ follow-up may be needed to
provide answers about some health effects, such as cancer. This is because the interval between
the time of exposure to a cancer-causing agent and the time tumors develop - if they do - may be
many, many years. The interpretation of epidemiological studies is hampered by difficulties in
measuring actual RF exposure during day-to-day use of wireless phones. Many factors affect this
measurement, such as the angle at which the phone is held, or which model of phone is used.

6. What is FDA doing to find out more about the possible health effects of wireless phone
RF?

FDA is working with the U.S. National Toxicology Program and with groups of investigators around

the world to ensure that high priority animal studies are conducted to address important questions

about the effects of exposure to radiofrequency energy (RF).

FDA has been a leading participant in the World Health Organization International Electromagnetic
Fields (EMF) Project since its inception in 1996. An influential result of this work has been the
development of a detailed agenda of research needs that has driven the establishment of new
research programs around the world. The Project has also helped develop a series of public
information documents on EMF issues.

FDA and the Cellular Telecommunications & Internet Association (CTIA) have a formal Cooperative
Research and Development Agreement (CRADA) to do research on wireless phone safety. FDA
provides the scientific oversight, obtaining input from experts in government, industry, and
academic organizations. CTIA-funded research is conducted through contracts to independent
investigators. The initial research will include both laboratory studies and studies of wireless phone
users. The CRADA will also include a broad assessment of additional research needs in the
context of the latest research developments around the world.

7. How can | find out how much radiofrequency energy exposure | can get by using my
wireless phone?

All phones sold in the United States must comply with Federal Communications Commission
(FCC) guidelines that limit radiofrequency energy (RF) exposures. FCC established these
guidelines in consultation with FDA and the other federal health and safety agencies. The FCC limit
for RF exposure from wireless telephones is set at a Specific Absorption Rate (SAR) of 1.6 watts
per kilogram (1.6 W/kg). The FCC limit is consistent with the safety standards developed by the
Institute of Electrical and Electronic Engineering (IEEE) and the National Council on Radiation
Protection and Measurement. The exposure limit takes into consideration the body’s ability to
remove heat from the tissues that absorb energy from the wireless phone and is set well below
levels known to have effects.
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Manufacturers of wireless phones must report the RF exposure level for each model of phone to

the FCC. The FCC website (http://www.fcc.gov/oet/rfsafety) gives directions for locating the FCC

identification number on your phone so you can find your phone’s RF exposure level in the online
listing.

8. What has FDA done to measure the radiofrequency energy coming from wireless
phones?

The Institute of Electrical and Electronic Engineers (IEEE) is developing a technical standard for
measuring the radiofrequency energy (RF) exposure from wireless phones and other wireless
handsets with the participation and leadership of FDA scientists and engineers. The standard,
“Recommended Practice for Determining the Spatial-Peak Specific Absorption Rate (SAR) in the
Human Body Due to Wireless Communications devices: Experimental Techniques,” sets forth the
first consistent test methodology for measuring the rate at which RF is deposited in the heads of
wireless phone users. The test method uses a tissue-simulating model of the human head.
Standardized SAR test methodology is expected to greatly improve the consistency of
measurements made at different laboratories on the same phone. SAR is the measurement of the
amount of energy absorbed in tissue, either by the whole body or a small part of the body. It is
measured in watts/kg (or milliwatts/g) of matter. This measurement is used to determine whether a
wireless phone complies with safety guidelines.

9. What steps can | take to reduce my exposure to radiofrequency energy from my wireless
phone?

If there is a risk from these products—and at this point we do not know that there is—it is probably

very small. But if you are concerned about avoiding even potential risks, you can take a few simple

steps to minimize your exposure to radiofrequency energy (RF). Since time is a key factor in how

much exposure a person receives, reducing the amount of time spent using a wireless phone will

reduce RF exposure.

« |If you must conduct extended conversations by wireless phone every day, you could place more
distance between your body and the source of the RF, since the exposure level drops off
dramatically with distance. For example, you could use a headset and carry the wireless phone
away from your body or use a wireless phone connected to a remote antenna.

Again, the scientific data do not demonstrate that wireless phones are harmful. But if you are
concerned about the RF exposure from these products, you can use measures like those
described above to reduce your RF exposure from wireless phone use.

10. What about children using wireless phones?

The scientific evidence does not show a danger to users of wireless phones, including children and
teenagers. If you want to take steps to lower exposure to radiofrequency energy (RF), the
measures described above would apply to children and teenagers using wireless phones.
Reducing the time of wireless phone use and increasing the distance between the user and the RF
source will reduce RF exposure.
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Some groups sponsored by other national governments have advised that children be discouraged
from using wireless phones at all. For example, the government in the United Kingdom distributed
leaflets containing such a recommendation in December 2000. They noted that no evidence exists
that using a wireless phone causes brain tumors or other ill effects. Their recommendation to limit
wireless phone use by children was strictly precautionary; it was not based on scientific evidence
that any health hazard exists.

11.What about wireless phone interference with medical equipment?

Radiofrequency energy (RF) from wireless phones can interact with some electronic devices. For
this reason, FDA helped develop a detailed test method to measure electromagnetic interference
(EMI) of implanted cardiac pacemakers and defibrillators from wireless telephones. This test
method is now part of a standard sponsored by the Association for the Advancement of Medical
instrumentation (AAMI). The final draft, a joint effort by FDA, medical device manufacturers, and
many other groups, was completed in late 2000. This standard will allow manufacturers to ensure
that cardiac pacemakers and defibrillators are safe from wireless phone EMI.

FDA has tested hearing aids for interference from handheld wireless phones and helped develop a
voluntary standard sponsored by the Institute of Electrical and Electronic Engineers (IEEE). This
standard specifies test methods and performance requirements for hearing aids and wireless
phones so that that no interference occurs when a person uses a “compatible” phone and a
“compatible” hearing aid at the same time. This standard was approved by the IEEE in 2000.
FDA continues to monitor the use of wireless phones for possible interactions with other medical
devices. Should harmful interference be found to occur, FDA will conduct testing to assess the
interference and work to resolve the problem.

12. Where can | find additional information?

For additional information, please refer to the following resources:

» FDA web page on wireless phones (http://www.fda.gov/cdrh/phones/index.html)

» Federal Communications Commission (FCC) RF Safety Program (http://www.fcc.gov/oet/rfsafety)
* International Commission on Non-lonizing Radiation Protection (http://www.icnirp.de)

» World Health Organization (WHO) International EMF Project (http://www.who.int/emf)

» National Radiological Protection Board (UK) (http://www.nrpb.org.uk/)
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